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Document Warranty

1. The information contained in this document is subject to change without prior notice.

2. The PNMS/PNMT screenshots in this manual are only examples. Screens will vary according to
equipment configurations, operation modes, setting parameters, PNMS/PNMT application program
version, etc. Screens contained in this manual are current at the moment of publication, and may
differ slightly from the actual screens on your PNMS/PNMT.

3. To use this manual, that you need a sound understanding of the restrictions, limitations and
precautions involved in operating the equipment properly. Always refer to the respective manual to
ensure proper operation of the equipment.
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1.2

Introduction
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The PASOLINK Network Management Terminal (PNMT) was developed by NEC to manage its
PASOLINK fixed point-to-point wireless access system networks. The PNMT is a scaled down
version of the PASOLINK Network Management System (PNMS) that is designed as a
maintenance tool for field engineers to locally and remotely monitor alarms, control points,
generate reports, and archive data, all within a familiar graphical user interface, and all in real time.
The PNMT is a mobile laptop computer fitted with the NEC PNMT software package that
interfaces and controls NEC PASOLINK series short haul wireless communications equipment.

This software package remotely monitors and controls the status and configuration of an entire
PASOLINK network with associated equipment including performance of the actual microwave

links.

Conventions Used in This Manual

Font What the Font Represents Example

Italics For manual titles or related Please refer to PASOLINK Operation

document names. Manual for details.

Hostname Items (phrases) in the user

Bold (or bold | interface. The Overall window

italics) Items (phrases) in the computer

display.
File and directory names.

[Button] Buttons in the user interface. Click on [OK] button to continue
Click on [Execute] button to send
command.

Menu Items A menu name followed by a Select System = Login/Logout

colon (:) means that you must

select the menu and then item.

When the menu item is followed

by an arrow (), a cascading

menu is displayed.

A command variable for which <password>
<username> the user must enter the

appropriate value.
This is also commonly used when
asking for a password.

Keyboard keys.

Press key.
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1.3 PNMT Communication Interfaces
1.3.1 Communications

Communications between the PNMT and the wireless communications network equipment can be

e via the PNMT port of the equipment,

e via the DSC to a remote node in the network.

1.3.1.1 PNMT Port Interface
The PNMT port is located on the front of the equipment.

(i) —c—= [ Jaea] | [0c0 d
[F=—al"=—77 m OoJom—T0

140 (4x2M), 140 (20x2M)

1+0, 1+0 (Expandable), 1+1 (Hot Stand-by), 1+1 (Twin Path)
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The PNMT port consists of an RJ-45 connector that plugs into Control (CTRL) Module installed in
the IDU via a serial cable which connects to the relevant communications port of the PNMT
Computer.

The PNMT port has the following properties:

e Port Configuration: RS-232

e Connector type: RJ-45 modular jack

e Bit per second rate: 1200/2400/4800/9600/19200 (default 19200)
e Stop bits: 1

e Data bit length: 8

e Parity: None.

The following table shows the pin allocation for the connection between the IDU PNMT port and
the PNMT PC.

PNMT (PC) to PNMT port (PASOLINK Mx)
3m
D-sub 9-pin (F) RJ45
PC (PNMT) PASOLINK Mx
PNMT port
RS-232C RS-232C

1 DCD 1 1 1 CD
2 RXD 2 2 2 TXD
3 TXD 3 3 3 RXD
4 DTR 4 4 4 DSR
5 GND 5 5 5 GND
6 DSR 6 6 6 DTR
7 RTS 7 7 7 CTS
8 CTS 8 8 8 RTS
9 RI 9

Cabling Diagram for PNMT PC to PNMT Port connections
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14 Equipment Configuration of PASOLINK Mx
PASOLINK Mx has 6 types of IDU.

1+0 (4 x 2M)

140 (20 x 2M)

1+0

1+0 (Expandable)

1+1 (Hot Stand-by)

1+1 (Twin Path)

Every IDU has 2 optional slots.

1+0 (4 x 2M) and 1+0 (20 x 2M) can support TNS Card / PNMS Card in Slotl, and LAN INTFC-S
in Slot2. 1+0, 1+0 (Expandable), 1+1 (Hot Stand-By) and 1+1 (Twin Path) support 2M INTFC-M
(32 x 2M) in Slot1, and 2M INTFC-S (8 x 2M) / LAN INTFC-S in Slot2.

r Slot1 r Slot 2

= == ==Rl=r=
o Oo om0

140 (4 X 2M), 1+0 (20 X 2M)

Slot 1 — Slot2
@l 5]
[ (o | | ooooo
@HMM ‘0 0‘ ‘o 0‘ 0000

1+0, 1+0 (Expandable), 1+1 (Hot Stand-by), 1+1 (Twin Path)
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2 System Operation & Maintenance

This chapter explains the menu structure and procedures for operating of the PNMT. The
explanation uses typical PNMT screenshots to illustrate the menu hierarchy.

2.1 The PNMT Screen

The PNMT window is composed of the following main areas (Refer to Figure 1).

Title bar
The title bar of a window is used to indicate the title of the window.

Standard Menu bar

The common menu bar of the window presents the System and Help options, illustrates which
commands can be executed from among the various options. The Help function can also
display a PDF version of this operation manual.

NE-specific Menu bar

This menu is a list of functions involving the network element (NE) displayed in the PNMT.
Configuration, Event Log, and Link Performance Monitor functions can be executed with the
NE-specific Menu bar.

Block Diagram
The block diagram shows the equipment comprising the PASOLINK Mx wireless

communication system. Its main purpose is to show the current alarm status summary for the
equipment in the display window. You can click on a specific block to display the status of the
network elements (NE) in the data window.

Data window
This window displays in detail the status and alarm items of a specific NE. You can select the
tab or the block of a specific NE which you wish to monitor in the data window.

Tabs
To view the status and alarms in the specific part of the NE, click on the tab at the bottom of
the Data window.

User Login
This indicates the user who is currently logged-in to the PNMT.

One Touch Expandable Button / Divider
Initially the PNMT screen is split evenly to display the data from the two NE’s withing a hop
by using a divider. Click this button to move the divider to the edge of the window.
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One Touch
NE-Specific Menu B Expandable Block Diagram
Title Bar -dDEC1IIC Vienu bar Button
asolink Network Management Terminal
System  Refresh  Help
Standard .
=GO @
Menu Bar v
Selected Metwork Element |: Opposite Netwdrk Element
Standard \ﬁ,’w ME Stored Loy & Perfw é Configuéﬂon ME Stored Log \@ Performancetdanitar
TOOI Bar Mo 001 [ Pasolink Mx ] Mo 002 [ Paso%k M= ]
CTRL O CTRL LFH
T Frequency 17810.000MHz T Frequency 18820.000MHz
R Frequency 18820.000MHz R Freguency 17810.000mMHz
WTPC T Fower -10dB MTPC T Power -24dB
Frame ID 1 Frame ID 1

T Power Contral MTPC TH Power Caontral MTPC

Data —> Slot 1 Blank Slot1 Blank
Window Slot 2 LAN INTFC-5 Slot 2 LAM INTFC-5

Transmission Capacity S0Mbps Transmission Capacity S0hhps

Modulation 1EQAM Modulation THRAM

<_ [» <

tgueral | oou [ iou | amcwo | cir oersion |

|»

| overan [ opu

ou | awcuo | cTRL | version |
Ready (Iﬁ Admin
3 \
Tabs .
Divider User login
& ATPC TX MAX Power - 10 x|
Mo.001
ATPC T MAN Power

| e i

| Execute || Cloze |

<—

—— Selectable Field

Command Button

Figure 1 Standard Components of PNMT Window

=10 x]
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2.2 Launching the PNMT Application
To start PNMT:

1. Turn system power ON .

NOTE

Connect the PNMT cable 30 seconds after IDU power has been
turned ON and make sure that the PNMT cable is connected
between Com 1 port of the PNMT PC and the PNMT port of the
IDU.

2. Login to Windows.
3. Click Start & Programs - PNMT]j = Pnmt, then continue to the login window.

PHMT ]|
NEC

Fleaze enter uzer name and passwward.

User name

Pazzword :

NOTE

Please do not change the clock settings of your computer once
PNMT has started.
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2.3 Login
Users are registered by means of login name and password.

To protect the network and the network management system from unauthorized access or
modifications, five levels of users with different access privileges are defined (refer to the table
shown in section 2.3.1 User Access Privilege Levels). The functions available in the window
depend on the individual user’s access level. .

The highest or administrator level has full access to the network and the management system.
To login:
1. Start PNMT, and then Login window appears.

OO

NEC

Fleaze enter uzer name and passward.

=er natne :

Pazsward

Login window

2. Enter the <User name>.
3. Enter the valid <Password> for the specific user.
4. Click [Login].

If you wish to exit the program, click [Exit].
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23.1 User Access Privilege Levels

v': Available, -: Not Available

Functions

User Name and Accessible Functions

Category

ITEM Monitor | User | Local | Remote

Admin

SYSTEM

ALARM BUZZER - v v

CONNECT(Remote Login) - -

SUMMARY

MODULE DETECTED v v
(Show Module Detected Symbol)

MODULE DETECTED
(Open Control-Equipment Setup)

IDU

COMMON/MAIN INTFC

DETAIL v

AUX I/O

INPUT -

OUTPUT -

RELAY CONFIGURATION -

CTRL

CONTROL

AR AYRYANA R NI
ANRSAYAYANA SRR NEERNANRN

DATE/TIME - -
CPU RESET - -

DOWNLOAD

CONFIGURATION FILE - - R

PROGRAM FILE - - -

EQUIPMENT CONFIG. FILE - - - -

UPLOAD

CONFIGURATION FILE - - - R

EQUIPMENT CONFIL.G. FILE - - R

IP NETWORK SETTING

IP NETWORK - -

EQUIPMENT
SETUP

EQUIPMENT SETUP

SETUP - -

CTRL

NE NAME - -

NOTE - v

PROVISIONING

MTPC STATUS

MTPC TX POWER - -

RX THRESHOLD - -

ADDITIONAL ATT - -

ATPC STATUS

ATPC (MAX) B -

ATPC (MIN) - -

RX THRESHOLD - -

ADDITIONAL ATT - -

ODU ALM MODE - -

BER ALM THRESHOLD

HIGH BER - -

LOW BER - -

CLUSTER ALM SETTING

CLUSTER ALM 1 - -

CLUSTER ALM 2 - N

SW PRIORITY

TX SW PRIORITY - -

RX SW PRIORITY - -

MAIN INTFC SETTING

CHANNEL USAGE ERROR REPORT - -

AIS RECEIVED REPORT - N

AIS GENERATED REPORT - N

AIS RECEIVED CONDITION SETTING - -

CHANNEL USAGE - -

AIS ACTIVARTION

AIS ACTIVATION CONDITION - -

SC ASSIGNMENT

SETTING - -

LAN INTFC-S

PORT SETTING - -

LAN INTFC-M

PORT SETTING - N

MAINTENANCE

MAINT - v

TX SWITCH - -

RX SWITCH - -

2 PORT LAN RESET - -

4 PORT LAN RESET - -

TX/RX FREQUENCY - -

SUB BAND - -

TX MUTE - N

IF LOOPBACK - -

Ccw - -

ATPC MANUAL - -

SHIFT FREQUENCY - -

ANTENNA ALIGNMENT MODE - -

2M CH LOOPBACK-1/2

2M CH LOOPBACK -

2M CH LOOPBACK-1 ALL CH RESET -

2M CH LOOPBACK-2 ALL CH RESET -

EVENT LOG

SAVE TO DISK -

PMON

PMON

PMON THRESHOLD -

A R A A R R A A AR A S A YRR SASANANENENENANENANENENANENENENENANENENANANANENRNANANENANRNANE
AN RS A AR YRS A AYAYASA A YANANASANANENANENANANANENANANENANANANANENENANANANENENANANENANANANE

ANRNANE

SAVE TO DISK -

ANANANENANENANANANENANANENANRNANENANENANENANENANANENANENANENANANENANANANENANENANANRNANRNANANANANANANANANANANENANE NI NI A AY

*Admin:
*Remote:

*Local:

*User:
*Monotor:

Enable to access to the all Network Elements.

Enable to access to the all Network Elements.

(Disable to change network configuration and change program with downloading)
Enable to access to Local NE and Opposite NE.

(Disable to change network configuration and change program with downloading)
Enable to access to items which doesn't effect to the equipment.

Enable to monitor only and disablet to control.

-10 -




2.4 Shutting Down PNMT
To close the PNMT application:

1. Click System -> Exit on the Menu bar of the main window

|'_5E1i1illPasoIink MNetwork Manageme

- Refresh Help

Change Password...

Alarm Buzzer...
elected |

Connect...

stored L

[ Mo 001

2. Click [OK] to confirm closing the application.

PNMT

Do yaou want to exit PRMTY

EalE

x|

-11 -
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2.5 Searching for and Connecting to Selected Network Elements

The summary description of the current network element (Network Element Name, Equipment
Type, Opposite Network Element, etc.) where PNMT is connected is displayed with this function.
Summary description of the opposite network element belonging to that link is also displayed.

To search for or connect to, a particular Network Element:

1. Click System = Connect ... on menu bar of PNMT main window.

|f;§:ii:-Pasulink Network Manageme

5ys1&m| Refresh Help

Change Password...

Alarm Buzzer...

elected I
Connect... \
tored L
Exit \
x T 001
- Metwork Element List N [m]
Li=st
a
Metwark Element Mame || Equiprment Type || Opposite Metwark Elern.... || IP address
Mo .00 Pasalink x 1+1 Twwin Path  Mo.002 172.015.000.001
Mo 002 Pasalink h:x 1+1 Twin Path [Mo.0o 172.015.000.002

NOTE

Initially only the current NE physically connected to the
PNMT and its opposite NE counterpart will be shown in the
Network Element List.

2. Click & icon in the tool bar or List = Search for Network Element in the menu bar
onfthe Network Element List window to display all connectable Network Elements in the
network.

3. Select and highlight the network element to be viewed.

A

4. Click # icon in the tool bar or List & Connect to Network Element in the menu bar of
the network element List window. The PNMT main window of the selected network
element and its opposite NE counterpart will be displayed.

x

Do you want to connect to the selected Netweark Element 7

| Ok || Cancel |
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2.6 Change Password

To change the password:

1. Click System = Change Password in the menu bar of the main window.

¢ Pasolink Network Managems

System | Refresh Help

Change Password... ~

Alarm Buzzer...
m

Connect...
Stored L Change Password x|

Exit Old password
Mo 001 | |

Merwy pazsword
| |

Canfirtn newy password |

Enter the Old password.
Enter New Password
Enter new password in the Confirm New Password field to confirm.

Click [OK].

vk »e

NOTE

For details on initial user name and password, please refer to
PNMT Installation manual.
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2.7  Alarm Buzzer Setting

This function is used to activate and set the Alarm Buzzer. The desired sound scheme can also be
set using this function.

To set the Alarm Buzzer:

1. Click System - Alarm Buzzer in the main window.

#% Pasolink Network Manageme

System | Refresh Help

Change Password...

Alarm Buzzer... ___.

Connect...

Exit

Moo

Alarm Buzzer

Alarm Buzzer |

i@ Mo sound

i) Wave fil

| QK | ‘ Cancel

2. Select the Wave file box to activate the buzzer. No sound is the initial factory setting of
the PNMT.

3. Enter the location of the sound file (*.wav) Otherwise; click [...] to locate the desired file.
You can also preview the *.wav file by clicking on the arrow next to the browse button.

4. Click [OK] to activate the new setting.

NOTE

When the text column is blank, it is possible to set it.
Otherwise, the buzzer does not sound.
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Refresh
This function is available only for PNMT. This function enables PNMT to acquire all status data
manually and t NE information to be updated.

To Refresh:

1.

Click Refresh = Refresh in the main window or click on the refresh icon in the tool bar.

[ Pasolink Network Manz |'_iEZilillPasulink Network Mang
System | Refresh | Help Systern Refresh Help
2s Y| Refresh 2|
Se Refresh SE
2 Configuration ME St x Configuration ME =
NOTE

Metered items such as TX power, RX level, power supply and
BER are automatically refreshed every 15 seconds. This
function is used when the immediate refresh of these metered
items is necessary or when immediate confirmation of all
current status information is required.
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Remote Viewing PNMT main window

You can view a target link within one Root-NE cluster of the Pasolink+ network by searching
through the connected NE’s and then connecting to a target NE. Please refer to Section 2.5
Searching for and Connecting to Selected Network Elements. This function allows remote

connection to any NE in the network.

NOTE: For multi-Root-NE network, you can only connect to NE’s that belong to the same network as
Root-NE as the local NE to which you are directly connected — via the PNMT cable.

Pasolink Network Manageme

System | Refresh Help
Change Password...
Alarm Buzzer...
elected r
Connect... \
ptared Lo
Exit \ -
\ Mo.001
etwork Element List o ] b
List
(=]
Metwark Element Mame || Equiprment Type || Cpposite Metwark Eletment || IP address
o001 Pasalink hx 1+0 Mo.002 172.018.000.033
o002 Pasalink W 1+0 Mo.0o1 172.015.000.034

=10l ]

Pasolink Network Management Terminal

System  Refresh  Help

= O @

Selected Metwoark Element : Opposite Network Element |

129 Configuration ME Stored Log & PerformanceMaritor 129 Configurstion ME Stored Log & PerformanceMaritor

Mo.001 [ Pasolink hx | Mo.002 [ Pasolink x|

=

TH Freguency 17810.000MHz : TH Freguency 18820.000MHz
R Frequency 18520.000mMHz : R Frequency 17810.000mMHz
MTPC T Power -10dB : MTPIC T P ower -24 dB
Frame ID 1 : Frame ID 1
T Power Control MTPC : T Power Control MTPC
Slot 1 Blank : Slot 1 Elank
Slot 2 LAM INTFC-5 : Slot 2 LAM INTFC-5
Transmission Capacity S0mMbps : Transmission Capacity S0Mbps
hiodulation 16QAM 5 Modulation 1HCAM

[ »

D] {31
LOveraII LODU Iou ALK WO LCTRL LVerSion | ;LOveraII LODU Iou ALK WO LCTRL L\u"ersion |

Fead B Adrin
y

PNMT Main window (1+0 configuration)
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2.10 License
To protect PNMT functions, the PNMT application includes license files.

To display the current license status,

1. Click Help = License ... in the main window.

(¥ Pasolink Network Management T

Systemn  Refresh Help|

= o @ Help »
Ahout...

iy
License... I
FCaniguratiun Sl ME Stored Loy

Mo.001 [ Psk_\
ey | Walue
License Type Pertnit ez

Licenze

Support Metwork Search Supparted

When changing the license file, click [Import].

-17 -
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2.11 Module Detected Symbol

If IDU detects the difference between the module configuration and currently inserted modules in
the slot(s), module detected symbol (E|) will be flashed in the block-diagram portion of the PNMT
screen. You can click on this symbol to be redirected to the Equipment Setup window or go to
Configuration 2 Equipment Setup = Slot/LAN tab to synchronize the module configuration.

Module Mo.001 [ Pasolink s ]
Detected
Symbol ~™—a MAINT | [ ALK |
] DU |—| oou f—
LFM | [ CTREL |

.

& Equipment Setup - |EI|5|

Mo 001

[ Esuipment | Siotan |

| Transmission Capacity | 80 Mbps

Insetted Madule

Slot 1 BL Ak i IT Slat 1 20 INTFC-M{ 32200
LA IMNTFC-5 i Slat 2 LAk IMTFC-S

Slot 2
LAN IMNTFC-%
2Paort LAKN == Radio Mapping " Port1-2 Sharedi Port Only (Main) d |
2Port LAN PI-P2HP B0 Mbps v | | -
2ZMIET] Assignment

1. Click [<-] symbol to apply the detected (inserted) module in the configuration.

(See 2.18 Equipment Setup)
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Overall Tab

This tab is displayed at startup. The Overall tab provides an overall snapshot of the most
significant monitored items in the NE.

The Overall tab gives a snapshot of the important settings of the NE. This window only displays
current settings and there is no control function associated with this window.

TH Freguency 19309.500 MHz
R¥ Frequency 18301 400 MHz
MTPC T Power -24 dB
Frame ID 1
Overall Tab == T T
. - ower Contro
+
(1+0 configuration) TE SRVE Card
Slot 2 LAM INTFC-5
Transmission Capacity 10MbpsFix
hModulation 1ACAM
Mol Mo 2
Overall Tab THA Freguency 12754 500 MHz | 12754.500 MHz
(1+1 Configuration) R Frequency 13020500 MHz | 13020.500 MHz
MTRC T Power -24 dB -24 dB
Frame |01 1 2
T¥ Power Caontrol MTPC
Slot1 20 INTF C-h{3 252}
Slot 2 2M INTFC-5
Transmission Capacity alhhps
Modulation 1E2AM
| Selected R | Mo,

The following items are displayed with this tab:

TX Frequency — the currently used transmission frequency.
RX Frequency — the currently used reception frequency

MTPC TX Power — the current value (in dB) of the Manual Transmitter Power Control
attenuation set in the ODU. The MTPC Attenuation will only have a valid data if the MTPC is
enabled.

Frame ID — the current predefined value of the frame ID of the NE.

TX Power Control — shows the current power control mode used by the ODU. The TX
Power Control is either Automatic Transmitter Power Control (ATPC) or Manual Transmitter
Power Control (MTPC).

Slotl — the current setting of Slotl.

Slot2 — the current setting of Slot2.

Transmission Capacity — shows the transmission capacity of the system.
Modulation — the current modulation type used.

Selected TX (for hot standby configuration only) — shows the currently used signal
transmission.

Selected RX (for 1+1 system only) — shows the currently used signal reception system.
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2.13 ODU Tab

This function is used to display the values and status of the monitored items of the ODU. This
window only displays current settings and there are no control functions associated with this
window.

To set the ODU parameters see the chapters on Equipment Setup and Provisioning.

2.13.1 ODU Tab
To view the alarm and status display of the ODU:
1. Click ODU tab in PNMT main window of the target NE.

rODuU
rTX
Alarm
TR IMPUT
TH POWER:
Metering
[ THPower | -5 0Bm |
rRX
Alarn
R LEVEL ODU Tab
Metering (1+0 Configuration)
[ PBxlevel [ -B0dBm |
rCOMMON
Alarn
APC
QDL CPL
Metering
[ Power Supply | A1 |
rHo.1 ODU rHo.2 ODU
rTX rTX
Alarm Alarm
THINPUT TH INPUT
T# POWWER T POWWER
Metering Metering
[ THPower | -5 dBm | [ THPower | -5 dBm |
rRX rR¥
Alarm Mot Selected Alarm Selacted
R LEVEL Fx LEVEL
Metering Metering
[ R¥level | -60dBm | [ R¥level | -61dBm |
rCOMMON rCOMMON
Alarm Alarm
AP AP
oDl CPLU oDl CPLU
Metering Metering
[ Power Supply | ATy | [ Power Supply | ATy |

ODU Tab (1+1 Configuration)
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Monitored Items in the ODU

TX PORTION
Alarm

0 TXINPUT: alarm occurs when the TX IF input signal from the IDU is lost. [tem/Status area is
shown with transparency letters and gray background in case PS Alarm, ODU CPU Alarm or IF
Cable Short Alarm.

0 TXPOWER: TX RF Power decreases 3 to 6 dB from nominal value. Item/Status area is shown
with transparency letters and gray background in case PS Alarm, ODU CPU Alarm or IF Cable
Short Alarm.

0 Selected/Not Selected: shows the current system used for signal transmission.
(for 1+1 systems only)

Metering

TX Power: The transmitted power of the ODU in dBm. Item and status area are shown and item area
filled with black font, status is no information in case PS Alarm, ODU CPU Alarm or IF Cable Short
Alarm.

RX PORTION
Alarm

0 RXLEVEL: alarm occurs when the input level decreases by preset value from squelch level.
Item/Status area is shown with transparency letters and gray background in case PS Alarm, ODU
CPU Alarm or IF Cable Short Alarm.

0 Selected/Not Selected: shows the current system used for signal reception.
(for 1+1 systems only)

Metering

RX Level: The received level interpreted in dBm. Item and status area are shown and item area filled
with black font, status is no information in case PS Alarm, ODU CPU Alarm or IF Cable Short
Alarm.

COMMON PORTION

Alarm

0 APC: this alarm occurs when the Local Oscillator is locked out. Item/Status area is shown with
transparency letters and gray background in case PS Alarm, ODU CPU Alarm or IF Cable Short
Alarm.

0 ODU CPU: this alarm occurs when the communication between the ODU and the IDU is lost.
Item/Status area is shown with transparency letters and gray background in case PS Alarm

Metering

Power Supply: Display PS voltage value (V). Item/Status area is shown with transparency letters and
gray background in case PS Alarm, ODU CPU Alarm or IF Cable Short Alarm.
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2.14 IDU Tab

This function is to display the values and status of the monitored items of the IDU. This window
only displays current settings and there is no control functions associated with this window.

To set the IDU parameters see the chapters on Equipment Setup and Provisioning.

2.14.1 IDU Tab
To view the alarm and status of the IDU:

1. Select the IDU tab in PNMT main window of the target NE. The figure below illustrates
the difference between the IDU tab of a 1+0 and a 1+1 system. Only the TX, RX and
Common portion are different for both systems.

r Module
Alarm
mAIR BOARD Marmal
[ MODEWM |  HMormal | IRTF G- Rormal
IMTFC-5 Mormal
rTX
Alarm
r R
Alarm
DEM
LOF
HIGH BER
LW BER
rODU INTFC
Alarm
[F CAELE SHORT] 0ODUGCPU |
r COMMON
Metering
EER | 0.0E-8 |
rMain Interface
Alarm/Status (Summany)
USAGE ERROR INPUT LOSS QOUTPUT LOS AlS RECEIVED AlS GERERATED
Summary-Mormal Summary-Mormal Surnmar-kMormal | Summan-Received [ Summar-Mormal
rLAN INTFC-S
Port FPort2
Fort Llsage Used Used
Link Link Link
Speed & Duplex 10M-HALF MDD | 10M-HALF (WMD)
Collision [Horrmal ormal
Link Loss Forwarding Narmal Marrmal

IDU window (1+0 Configuration)
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rModule
Alarm
40,1 4o, 2 MAIN BOARD Mormal
WMODER Mormal Mormal IMTFC-f Mormal
Power Supply Maormal Mormal INTFC-5 Mormal
rMo.1 MD UNIT rMo.2 MD UNIT
rTX rTX
Alarm Alarm
[ife]n] [ife]n]
rR¥ rR¥
Mot Selected Selected
Alarm Alarm
DEM DEM
LOF LOF
HIGH EER HIGH EER
Loy BER: Loy BER:
rODU INTFC rODU INTFC
Alarm Alarm
[IF CABLE SHORT[ ODUCGPU | [IF CABLE SHORT[ ODUCGPU |
r COMMON
Metering
BER [ 0.0E-8 |
rMain Interface
Alarm/Status {(Summany)
USAGE ERROR INPUT LOSS OUTPUT LOS AlS RECEIVED AlS GENERATED
Summanrn-kormal Summanrn-kormal Summan=kormal | Summan-Received | Summan-ktarmal
rLAM INTFC-S
Portl Fort2
FPort Usage Lsed Lsed
Link Link Link
Speed & Duplex 100-HALFMDE | 1 0hi-HALF (WD)
Collision [{ormal [arrmal
Link Loss Farwarding Harrmal Harrmal

IDU window (1+1 Configuration)

r COMMON
rMAIN INTFC{DETAIL})
USAGE LUEAGE ERROR INPUT LOSS QUTPUT LOSS AlS RECEIVED AlS GEMNERATED
Summan-rarmalSumman-MarmallSummans-klormall Summan-Received | Summary-Mormal
CHO1 ot Used marmal Formal ormal Received ormal
CHOZ Used [Hormal Marmal Marrmal Marrmal Narrmal
CHO3 Used [Hormal Marmal Marrmal Marrmal Narrmal
CHD4 Lsed [orrmal MHarmal Hormal Mormal Hormal
CHDS Lsed [orrmal MHarmal Hormal Mormal Hormal
CHOE Used Hormal Marmal mlarmal Marmal marmal
CHO7 Used Hormal Marmal mlarmal Marmal marmal
CHOg Used [Hormal Marmal Marrmal Marrmal Narrmal
CHOY Used [Hormal Marmal Marrmal Marrmal Narrmal
CH10 Lsed [orrmal MHarmal Hormal Mormal Hormal
CH11 Lsed [orrmal MHarmal Hormal Mormal Hormal
CH1z Used Hormal Marmal mlarmal Marmal marmal
CH13 Used Hormal Marmal mlarmal Marmal marmal
CH14 Used [Hormal Marmal Marrmal Marrmal Narrmal
CH15 Used [Hormal Marmal Marrmal Marrmal Narrmal
CH16 Lsed [orrmal MHarmal Hormal Mormal Hormal
CH1T Lsed [orrmal MHarmal Hormal Mormal Hormal
CH1g Used Hormal Marmal mlarmal Marmal marmal
CH149 Used Hormal Marmal mlarmal Marmal marmal
CH20 Used [aormal Marmal Marrmal Marmal Narrmal

Detail window of Main Interface
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Monitored Items in IDU Tab

MODULE
Alarm

0 MODEM: alarm occurs if there is a modem
failure. Item/Status area is shown with
transparency letters and gray background in
case PS Alarm.

0 Power supply: alarm occurs if the power
supply fails.

0 MAIN BOARD: alarm occurs when the
INTFC module or CPU (SUB) fails.

0 TNS/PNMS CARD: alarm occurs if when
TNS Card or PNMS Card in Slot1 fails.

0 INTFC-S: alarm occurs when the LAN
INTFC-S Card or 2M INTFC-S (8x2M) Card
in Slot2 fails.

MODEM
X
Alarm

0 MOD: alarm occurs when the TX unit
(modem) failed. Item/Status area is shown
with transparency letters and gray
background in case PS Alarm.

Status
0 Selected (for 1+1 systems only)

Selected/Not Selected (This portion of screen is
only active if 1+1 system is used)

This item shows if the System is selected or not
selected. Item/Status area is shown with
transparency letters and gray background in case
PS Alarm.

_24 -
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RX
Alarm

0 DEM: alarm occurs when the RX unit
(demodulator) fails or the IF signal is
lost. Ttem/Status area is shown with
transparency letters and gray background
in case PS Alarm.

0 LOF: loss of frame occurred. Item/Status
area is shown with transparency letters
and gray background in case PS Alarm.

0 HIGH BER: alarm occurs if the signal is
deteriorated below the threshold value.
Item/Status area is shown with
transparency letters and gray background
in case PS Alarm.

0 LOW BER: alarm occurs if the signal is
deteriorated below the threshold value.
Item/Status area is shown with
transparency letters and gray background
in case PS Alarm.

Status

0 Selected (for 1+1 systems only)

Selected/Not Selected (This portion of
screen is only active if 1+1 system is used)
This item shows if the System is selected
or not selected. Item/Status area is shown
with transparency letters and gray
background in case PS Alarm or CABLE
Alarm.

ODU INTFC
Alarm

0 IF CABLE SHORT: alarm occurs when
the cable between IDU and ODU is
shorted. Item/Status area is shown with
transparency letters and gray background
in case PS Alarm.

0 ODU CPU: alarm occurs when the
connection between IDU and ODU
disconnects. Item/Status area is shown
with transparency letters and gray
background in case PS Alarm or IF
CABLE SHORT Alarm.



COMMON

Metering

BER: The current overall value of the Bit-Error-
Rate

MAIN INTFC

Item/Status area is shown with transparency
letters and gray background in case every channel
is Not Used.

Alarm/Status

(0}

USAGE ERROR: alarm occurs when 2MB
bipolar signal is inputted into the channel that
has been chosen “Not Used”.

INPUT LOSS: alarm occurs when 2MB
bipolar signal is disconnected.

OUTPUT LOSS: alarm occurs when the
received signal from radio link is lost.

AIS RECEIVED: indicates the status of AIS
RECEIVED signal for transmitting channel
in the MAIN INTFC. Status area is shown
with transparency letters and gray
background in case AIS Received Report is
Not Reported.

AIS GENERATED: indicates the status of
AIS generation signal for receiving channel
in the MAIN INTFC. Status area is shown
with transparency letters and gray
background in case AIS Generated Report is
Not Reported.
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LAN INTFC-S

Item/Status area is shown with transparency
letters and gray background in case 2 Port
LAN Radio Mapping is Not Used.

0 Port Usage: enables to apply the each
port.

0 Link: alarm occurs when the link fails on
each port. Status area is shown with
transparency letters and gray background
in case Port Usage is Not Used.

0 Speed & Duplex: indicates the status of
Speed & Duplex. Status area is shown
with transparency letters and gray
background in case Port Usage is Not
Used.

0 Collision: indicates the status of
Collision. Status area is shown with
transparency letters and gray background
in case Port Usage is Not Used, Collision
Report is Not Reported or Speed &
Duplex is Full.

0 Link Loss Forwarding: indicates the
status of Link Loss Forwarding. Status
area is shown with transparency letters
and gray background in case Port Usage
is Not Used or Link Loss Forwarding is
Disable.



2.15 Auxiliary I/0O Tab

4-relay output and 6 photocoupler inputs
are provided in the IDU for external control

and alarms. The setting for

output/photocoupler input is enabled by
clicking on each device in the Auxiliary I/O

monitor window.

To monitor and set the Auxiliary 1/O:

1. Select the Aux. /O tab in the
PNMT main window

2.15.1 Monitored Items

Alarm ! Status ! Control

ROI-S05936

Input-1 ALlEIN-1 Qpen

h rel lhput-2 All¥ln-2 Open
cach relay Input-3 Auxln-3 Qpen
Input-4 Auxin-4 Cpen

Input-5 Auxln-a Cpen

Input-6 Auxin-6 Qpen

Ciutput-1 A1 Open

Cutput-2 AlxOut-2 Close

Ciutput-3 AuxOut-3 Close

Qutput-4 ALlEDUE-4 Close

Relay Confiquration

[ Relay Configuration |

Following items are monitored in this tab:

1. Six (6) photocoupler inputs. (Input-1 to Input-6)

2. Four (4)-relay outputs. (Output-1 to Output-4)

Aux. 1/0 window

When Cluster ALM Setting (Input) is enabled, following Input items are used as Cluster ALM.

1. When Cluster ALM1 is enabled, Input-6 item is used as Cluster ALM1.

2. When Cluster ALM2 is enabled, Input-5 item is used as Cluster ALM2.

2.15.2 Photocoupler Input Setting

To set the photocoupler input:

1. Click the selected [Input-n] in Aux. I/O window.

2. The input properties will be displayed in the ensuing window.

Marne

Mo 001

=101x]

|Au><ln-1

Condition

(W) Alarm yvhen Event ON

i) Mlarm when Evert OFF

i Status

Statuzs Strings

Evert OM: [Close

Event OFF:  Open

HI33

Serverity:

mEjor

Alarm Type

equiptnentAlarm

Probable Cause:

equipmenthlalfunction

Execute | | Cloze
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2.15.2.1 Setting the Selected Input to Alarm or Status

1.

Select the Condition and X.733 setting of the selected input. You can select the input
status when the target input will send the alarm event to the PNMS;j/PNMT]. Also you can
preset the input to just send the status event instead of the alarm event. The alarm input
severity is defined in the X.733 recommendations. Select the severity of the alarm, its type
and probable cause by clicking the pull-down arrow on the right-hand side of the field.

Enter the name and status strings of the selected input in the Name, Event ON and Event
OFF field. A maximum of 32 characters can be used.

Click [Execute] to activate the selected state of the device.

Click [Close] when finished.

2.15.3 Relay Output Setting

To set the relay output:
1.
2.

. . . =101 %

Click [Output-n] in Aux. 1/O window. o001
0.
To define the open or close status of the selected relay hatne
output, click Event ON or Event OFF respectively. [8pe0ut-1 |
Enter the desired strings for the open and close status of the Cantrol
relay output in the appropriate Event ON and Event OFF (@) Evert ON m
fields. A maximum of 32 characters can be used. T ’093”7
Click Name tab.
Execute | ‘ Cloze |

Enter the desired name of the relay output in the Name field.
A maximum of 32 characters can be used.

Click [Execute] to carry out the command.

Click [Close] when finished.

2.15.4 Relay Configuration

There are 7 relays in the IDU. Consequently, 7 parallel alarms can be defined. Relays RLO1, RL02
and RLO3 have fixed alarms. Maintenance, PS ALM and CPU Alarm are outputted on RLO1,
RLO02 and RLO3 respectively.

RLO04 to RLO7 are user-definable relays for Housekeeping (HK), Cluster alarm or other external
parallel alarms. If the HK-OUT’s are enabled, RL04 to RLO7 are allocated for Housekeeping (HK).
Cluster alarm 1 and 2 are outputted on RL0O7 and RLO06 respectively.

NOTE

Relays RL04 to RLO7 are available for allocation of Housekeeping
(HK), Cluster alarms and equipment alarms. These alarms are
outputted on the same relay.

CAUTION:

When setting RL07 or RL-06 to output the cluster alarm, it is
recommended that Housekeeping (HK) and equipment alarms be
removed from the form — this is to ensure that RL0O7 or RLO6 will
output only the cluster alarm.
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The PNMT allows the user to configure the relays in a table format. The columns indicate the
relays (RLO1 to RL0O7) and the rows indicate the parallel alarms available. The following indicators
are used in the table:

0 Out - indicates that the alarm - in the corresponding row, is issued on the
corresponding relay.

0 HK - Indicates that the corresponding relay is used for House Keeping.

a Blank button — not related to the corresponding alarm.

To set the relay configuration:
1. Click [Relay Configuration] in Aux. I/O window.

2. Select the HK-OUT used in the equipment. There are four (4) available HK-OUT’s in the
system. Selecting “1/2/3/4” button means all HK-OUT’s will be enable; “1/2/3” means
only HK-OUT 1, 2 and 3 will be enabled; and so on. If the HK-OUT’s will not be used,
select “Disable” button.

& Relay Configuration =101%]

Mo.001

~HK-CUT EMAEBLE
i iEs s e 1 i1 Dizahle

rRELAY COMFIGURATION

RLO1 RLOZ RLOG RLO4 RLOS RLOG RLO7
Output-1 (HK-0UT ) He =
Output-2(HH-OUT 2] HEk
Output-FHH-OUT3) HEk
Output-4(HH-OLIT4) HE
PS ALM Out
CRLALM Out
CRLALM Out
QDL CPU ALK A |
QDL CPU ALM 2 |
QDL ALK 1 |
QDL ALK 2 |
|

|

|

10U ALR A
DL AL 2
T PR ALK
T PR A2
T I ALK
TH I ALRZ2
R LEW ALM1
R LEW ALM2
APC AL
APC A2
IF CABLE SHORT AL...
IF CABLE SHORT AL...
RACICY A1

Jl

| Execute || Cloze |

3. Click the button(s) that corresponds to the target alarm(s) and relay(s).
4. Click [Execute] to apply the new relay configuration.
5. Click [Close] when finished.
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The following alarms are available for allocation on the relays.

Output=1{HK-0UT-12
Output-2iHK-0UT-23
Output-3iHE-0UT-3)
Output-4iHK-0LT-43
MAINT

PSS ALM

P ALM

QDU CPU ALK

QDU ALK

100U ALK

T PR AL

TR IN AL

R LEV ALM

AP ALM

IF GABLE SHORT ALM
MO0 ALK

DEM ALM

HIGH BER. ALM

LOW BER. ALM

LOF

INPUT LOSS
QUTPUT LOSS

A5 RECEIVED

Al5 GEMERATED
IUSAGE ERROR.
Clugter ALM 1
Clugter ALM 2

-: Mot Available
Out  |: Fixed Alarm Only
: Uzer-5Selectable

Relay Configuration List (1+0)
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Cutput-1{HK-DUT-13
Cutput-2 HE-0UT-2)
Cutput=3 (HkE-0UT-3)
Cutput-4 (HE-0UT-4)
MAINT

Fis ALM

CPLU ALM

00U GPU ALM 1

ODU GPU AlM 2

oDU ALM T

oDU ALM 2

IDU ALM 1

IDU ALM 2

T PR ALM 1

TA PWE ALM 2

TH IN ALMA

THIN ALM 2

R LEWV ALM 1

R LEWV ALM 2

APC ALM 1

APC ALM2

IF GABLE SHORT ALM 1

IF GABLE SHORT ALM 2

MOD ALM 1

MOD ALM 2

DEM ALM 1

DEM ALM 2

HIGH BER ALM 1

HIGH BER ALM 2

LOW BER ALK 1

LOW BER ALK 2

LOF 1

LOF 2

INPUT LOSS

OUTPUT LOSS

£1s RECEIVED

Als GEMERATED

USAGE ERROR

Clugter ALM 1

Clugter ALM 2

-: Mot Available
Ot

: Fixed Alarm Only
¢ Uzer-Selectable

Relay Configuration List (1+1)

NOTE

When maintenance mode is ON, all other alarms except HK and

cluster alarms are masked.
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2.16 Control (CTRL) Tab
2.16.1 Control Module

1. Select the CTRL tab in PNMT main window of the target NE. |J’-Iﬂrm |
Calendar
The following items can be monitored and controlled in the CTRL [ crucue |
window:
Control
e Calendar Alarm [ DateTime |
e CPU (SUB) Alarm | CPU Reset ]
e Date/Time Download { PC >» CTRL
Configuration File
* CPU Reset Program File
e Download Configuration File Equiprnent Config. File

Download Program File
Upload { CTRL >= PC
Configuration File

Download Equipment Configuration File

Upload Configuration File Equipment Config. File
Upload Equipment Configuration File Hetwork Setting
. [ IP Metwoark |
IP Network Setting
NOTE

Only Mx CTRL version 1.2.1 or higher supports Auto-discovery
and the connection to PNMT displays “IP Network Setting” items

2.16.2 Setting the Date/Time

The Date and Time stored in the Control module can be displayed and adjusted using this function.

To set the Date/Time:

1. Click [Date/Time] in the CTRL window.

& Date/Time =10l
Mo 001 NOTE
hacle
. _ To set the values of the Date and Time
Qeatekilm  DESpHe fields to the same value as the PNMT
e computer, check the Display PC Time box.
Date

| Execute H Cloze ‘

a.  To check the Date and Time on the Control module:

a-1. Select Get Date/Time in the Date/Time window.

a-2. Click [Execute].

a-3. The current date and time in the control will be displayed in the Date and Time field.
b. To set the Date and Time on the Control module:

b-1. Select Set Date/Time in the Date/Time window.

b-2 Enter the date at Date field in the MM/dd/yyyy format, where MM is for month, dd is
for date and yyyy is for year.
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b-3. Enter the time at the Time Field in the hh:mm format, where hh is for hour and mm is
for minutes.

b-4. Click [Execute].
b-5.  Click [Close] when finished.

2.16.3 CPU Reset

The Control module can be reset using this function

*The CPU Reset window is not available when MAINT is =101 %
OFF. Mo.001
Module Select
NOTE i CTRL
Resetting the Control module will not affect the
traffic. The connection to the selected NE will be Y CRUCSLIE)
lost a few minutes and will be automatically re-
connected. 3 oDU
i pod ) Mo.2
NOTE

1] hwith ROM{Program) switching
MAINT, TX Mute, CW, Loopback, ATPC Manual

and CH Loopback will be cleared and TX/RX
Switch will be Auto if the power is turned off and
on or the RESET switch is depressed.

Execute | | Cloze

To reset the Control module:
1. Click [CTRL Reset] in CTRL window.

2. You can select the “with ROM (Program) Switching” option if you want to switch to a
newly downloaded Control module Program file.

3. Click [Execute] to continue the Control module reset operation.

NOTE

Switch ON maintenance mode first before executing CPU Reset.
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2.16.4 Downloading the Configuration Files to the Control Module

This function is for download the network configuration files from the PNMT to the Control
module. The network configuration file — pp_network.cfg, contains the IP addresses of the target
NE as well opposite NE and the information about the network where the target NE is located. The
pp_mib.cfg file contains the information about the equipment (i.e. name, pm type, etc.) and
housekeeping (Aux. I/0).

To download the new configuration file to the CTRL:
1. Click [Configuration File] in the Download (PC>>CTRL) section on CTRL window.

& Download Configuration File - |EI|5|
Mo 001
Type File

Metwwork Config g _netweork.cfy Browese...

| Execute H Upiddate... || Cloze |

2. Select the type of file to be downloaded in the Type list.

3. Enter the location of the configuration file in the File field, or click [Browse] to locate the
file on the local hard disk or diskette.

WARNING!!!

Make sure that the correct configuration file is downloaded to
the correct Control module. Incorrect configuration files w
can cause Control module or network failure.

4. Click [Execute] to start the operation.
*[Execute] Button is only available when MAINT is ON.

NOTE

Switch ON maintenance mode first then executing the Download
Configuration File.

5. A message window indicating the status of the operation will appear. It will close
automatically once the operation is finished.

WARNING:

Make sure that you have successfully downloaded the
configuration file before attempting an Update. Otherwise the
Control module will switch to an empty ROM that may cause
the Control module failure.

6. Click [Update] to activate the new configuration file(s).

*[Update] Button is only available when MAINT is ON. (“Switch to
maintenance mode first” is displayed in case it is set to OFF.)
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7. Select the appropriate box for the type & update Configuration File o x|
of configuration file that will be o 001 '
updated. One or more configuration '
file(s) can be updated by checking the File
selection box of the configuration file ¥ Netwark Canfig

name. Click on [Execute] button to
start the operation. The "with ROM
(CTRL Program) Switching" box is
for switching to the ROM with the new [ weith ROM(CTRL Programn) Switching
CTRL Program and has the same
function that was previously described
in section 2.16.3 CPU Reset.

[¥] MIE Config

Execite | | Cloze

NOTE

When updating the pp_network.cfg file, NE-to-NE
communication will be lost when the Control module re-
initializes to the new system configuration. This WILL NOT
affect the radio link. During this time PNMT connection to the
NE will be disrupted but it will automatically be restored after
the Control module resets.

NOTE

Updating the CTRL will not affect the traffic. The connection to
the selected Pasolink will be disrupted for a few minutes but will
be automatically re-stored.

8. Click [Close] when done.

2.16.5 Downloading a new Program File to the Control Module

This function is used to update the application program on the Control module. This operation
affects only the NMS communication but not the wireless link, and will not disrupt communication.

To download the program file to Control module:

& Download Program File

=101 ]

1. Click [Program File] in the Download
(PC>>CTRL) section on CTRL
window. Module Select

(@ CTRL [ with Selt Reset
(® Main (' Boot
() CPUCSLE)

o001

)l onl

File

nh2se1 46| | Browse..

| Execute ‘ | CPU Reset... | | Cloze |
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Select the module select button of CTRL. If you tick the “with Self Reset” the Control
module will be reset automatically after program file download is completed. In this case,
you won’t need to do steps 5 thru 8.

Enter the appropriate location of the program file (*.out) in the File field. Otherwise, click
[Browse] to locate the file.

WARNING!!!

Make sure that the correct program file is downloaded to the
Control module. Incorrect program file will lead to failure.

Click [Execute] to start the operation.

*[Execute] Button is only available when MAINT is ON.

NOTE

Switch ON maintenance mode first before executing Download
Program File.

A message window will appear displaying the status of the operation. It will close
automatically once the download is completed.

NOTE

This operation may take several minutes depending on the
program file size

Click [CPU Reset...] to switch to the new program file.

*[CPU Reset] Button is only available when MAINT is ON. (“Switch to Maintenance
mode first” is displayed in case it is set to OFF.)

Check the with ROM (Program) Switching box.

Click [Execute] to complete the switch to the new program file.

NOTE

The connection to the selected NE will be disrupted a few
minutes will automatically be restored.

Click [Close] when done.
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2.16.6 Downloading the Equipment Configuration Files to the Control Module

This function is used to download equipment configuration files from the PNMT to the Control module.
The equipment configuration file contains the radio configuration data (i.e. frequency, main
interface) and provisioning data (i.e. BER alarm threshold).

To download new configuration file to the NE:

1. Click [Equipment Config. File] in the Download (PC>>CTRL) section on CTRL
window.

& Download Equipment Config. FI|E - |EI|5|

Mo, 001

Browwse...

File

Header Infarmation

ME_MAME="Mo.001"
IP_ADDRESS="172.18.0.33"
EQUIPMWENT _T*PE="Pazo+hx"
SUE_TYPE=""
DATE="200506/29 10:30:30"

| Execute || Update... H Cloze |

2. Click [Browse] to locate the file on the local hard disk or diskette.

WARNING!!!

Make sure that the correct equipment configuration file is
downloaded to the correct Control module. Incorrect
configuration file will lead to Control module or network failure.

3. Click [Execute] to start the operation.

*[Execute] Button is only available when MAINT is ON. (“Switch to maintenance mode
first” is displayed in case it is set to OFF.)

4. A message window indicating the status of the operation will appear. It will close
automatically once the operation is finished.

WARNING!!!

Make sure that you have successfully downloaded the
configuration file before doing Update. Otherwise the Control
module will switch to an empty ROM that may cause Control
module failure.
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5. Click [Update...] to activate the new equipment configuration file. Click [Execute] to
start the update operation.

*[Update] Button is only available & update Configuration File =10] x|
when MAINT is ON. No.0O
File
NOTE [¥] Equinment Config
Switch ON maintenance mode first
before executing Download
Equipment Configuration File. Execute ‘ | Close

NOTE

The connection to the selected NE will be lost a few minutes
and will automatically re-connect.

6. Click on [Close] button when done.

2.16.7 Uploading Configuration File to PNMT PC

This function is used to upload the configuration file from the Control module of the selected NE
to the PNMT PC.

To upload the configuration file from the Control module to the PNMT:
1. Click [Configuration File] in the Upload (CTRL>>PC) section of the CTRL window.

& Upload Caonfiguration File = Sl |
ME Simulator
Type File

|Netw-:urk Config | | Brovese. ..

Close

2. Select the type of file to be uploaded with the Type field.

3. Enter the desired file name for the uploaded file. And select the directory where the
uploaded file will be saved.

4. Click [Execute] to start the operation.

5. A message window indicating the status of the operation will appear. It will close
automatically once the operation is completed.

6. After the upload is finished, click [Close].

7. Verify that the file was uploaded to the specified directory.
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2.16.8 Uploading Equipment Configuration File to PNMT PC

This function is used to upload the equipment configuration file from the Control module of the
selected NE to the PNMT PC.

# upload Equipment Confie. File o ] B
Mo 00

prrentConti.cfy Browese. ..

File

| Execute || Cloze |

To upload the equipment configuration file from the Control module to the PNMT:

1.

Click [Equipment Config. File] in the Upload (CTRL>>PC) section of the CTRL
window.

Click [Execute] to start the operation.

Enter the desired file name for the uploaded file. And select the directory where the
uploaded file will be saved.

A message window indicating the status of the operation will appear. It will close
automatically once the operation is completed.

After the upload is finished, click [Close].

Verify that the file was uploaded to the specified directory.

2.16.9 Configuring the IP Network Settings

In order to operate Auto Discovery and Network function respectively for PNMS and PNMT it is
necessary in advance, to connect PNMT to each NE to set Network information

This function is used to configure the IP network settings (i.e. IP addresses, subnet masks, Default
gateway) using the tags in the lefthand field of the IP Network Settings window of the selected NE

for the PNMT PC.
Alarm & IP Hetwork Setting
Mo 001
CPLUSLIB General General
RadioMETLAN e
. 1=
Control Routing ¥
| DateTirme ] CTRL Tyne: MormalME |
[ CPU Reset | Port Information
Port [ Paddress | Subnet Mask
Download { PC ~> CTRL RadioME1LAN 0000 255255 255 162
Configuration File 11 1921681253 2552553550
Frogramm File
Equipment Canfig. File
Upload { CTRL = PC}

Configuration File

[Equiprnent Config, File

Hetwork Setting

IP Metwork ] | oose |

Please refer to Appendix A.
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There are several maintenance control items that can be executed in the maintenance menu. The
function of each control is as follows.

MAINT:
TX Switch:

RX Switch:

2Port LAN Reset:
TX/RX Frequency:
Sub Band:

TX Mute:

IF Loopback:

CW (MOD Carrier):
ATPC Manual:

Shift Frequency:

Antenna Alignment Mode:

Loopback-1:
Loopback-2:

To switch Maintenance mode to ON

To control the TX switch manually

(for 1+1 Hot Standby system only.)

To control the RX switch manually

(for 1+1 system only)

To reset LAN Ports of LAN INTFC-S interface
To set TX Frequency and RX Frequency

To select Sub Band

To turn off TX power

To set the IF loop back (Local only)

To turn on the Continuous Wave for measurements (Local only)

To use an optional transmitting power when the ATPC is in
operation

To select Shift Frequency (for 1+0(4x2M), 1+0(20x2M) only)

To turn on Antenna Alignment Mode (only available for the specific
type of ODU)

To set the loop back at the line input of E1

To set the loop back at the line output of E1

*These windows are not available when MAINT is OFF. (“Switch to Maintenance mode first” is

displayed.)

NOTE

MAINT, TX Mute, CW, Loopback and ATPC Manual will be cleared if the power is
turned off and on or the RESET switch is depressed.
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2.17.1 Maintenance Menu
To open the Maintenance window:
1. Select Configuration - Maintenance in the NE-specific menu bar.

This window contains the setup information of MAINT and several maintenance control items that
have to been set during Maintenance Mode. The Maintenance window is shown below.

Control
| MAIMT | QOFF |

[ 2PortL&M Port Reset |

TH Frequency 13045 000MHz
R Frequency 12779.000MHz
Freguency Channeal
Sub Band F
T Mute OFF
IF Loophack OFF
Yy OFF
ATPC Manual OFF
[_Antenna Alignment Mode | OFF |
rLOOPBACK-1/2
Loophback-1 Loophack-2
All CH Reset All CH Reset

CHO1 OFF OFF
CHOZ OFF OFF
CHO3 OFF OFF
CHO4 OFF OFF
CHO5 OFF OFF
CHOE OFF OFF
CHOY OFF OFF
CHOS OFF OFF
CHOS FF OFF
CH10 OFF OFF
CH11 OFF OFF
CH12 OFF OFF
CH13 OFF OFF
CH14 OFF OFF
CH1%5 OFF OFF
CH1E OFF OFF
CH17 OFF OFF
CH18 OFF OFF
CH19 OFF OFF
CHZD OFF DFF

Maintenance window (1+0 Configuration)
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[ MAINT [

OFF |

[ Reowich |

Mo.1 |

[ 2Port LAN Port Reset

ROI-S05936

_4] -

No.1 No.2
TH Freguency 13020.500 MHz TH Freguency 13020.500 MHz
R Freguency 127454 400 MHz H¥ Freguency 12754500 MHz
Freguency Channel Freguency Channel
Sub Band A Sub Band A
T Mute OFF TH Mute OFF
IF Loopback QOFF IF Loophback QOFF
iy OFF Chy OFF
ATPC Manual OFF ATPC Manual OFF
LOOPBACK-1:2
Loophack-1 Loophack-2
All CH Reset All CH Reset
ZHO1 OFF OFF ”
CHOZ OFF OFF
CHO3 OFF OFF
cHO4 OFF OFF
CHOS QFF QFF
CHOE OFF OFF
cHO7 OFF OFF
CHOg OFF OFF
ZHO9 OFF OFF
CH10 QFF QFF
ZH11 OFF OFF
CH12 OFF OFF
CH13 OFF OFF
CH14 OFF OFF
CH14G OFF OFF
CH1E OFF OFF
CH1T OFF OFF
CH18 OFF OFF
cH149 OFF OFF
cH20 OFF OFF
CH21 QFF QFF
CH22 OFF OFF "
Maintenance window (1+1 Configuration)
2.17.2 Selecting Maintenance Mode
To switch the NE to maintenance mode:
. _ EXO =101 x]
1. Click [MAINT] in Maintenance window. 2 o001
0.
2. Select ON/OFF depending on desired state. Mairtenarce
3. Click [Execute] to carry out the command. ® on () OFF
4. Click [Close] when finished. Execte || Close |
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2.17.3 TX Switch (for 1+1 Hot Stand-by system only)
To control the TX switch manually:
1. Click [TX Switch] in Maintenance window.

2. Select the system that you wish to use for the TX portion of the radio. The default setting
is Auto.

TX Switch - No.001

T Switch

f* Mo li " Buta " Mo.2

Execute Cloze

3. Click [Execute] to switch the TX to the selected system.

CAUTION:

CONMFIRMATION

When TX Switch is changed from the
This will effect the radio link connection. default setting (Auto) to either No.1 or No.2,

0 “’E?;g;;;‘lfle_ Eﬂ‘gg?rﬁ”‘a? the confirmation message appears.

If the TX switch has been manually
switched to either No.1 or No.2, the
confirmation message will NOT appear.
However, this operation still may affect the
radio link connection.

Yes Mo

4. Click [Close] when finished.

2.17.4 RX Switch (for 1+1 system only)

To control the RX switch manually:

1. Click [RX Switch] in Maintenance window. REE
2. Select the system that you wish to use for the RX Mar.001
portion of the radio. The default setting is Auto. R Syitch
3. Click [Execute] to switch the RX to the selected Mot @ Auo | (Mo2
system.
Execite | | Close |
4. Click [Close] when finished.
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2.17.5 2 Port LAN Reset
To reset LAN Ports of LAN INTFC-S interface:

1.

ROI-S05936

Click [2Port LAN Reset] in Maintenance
window.

LA Port Reset

Select the port that you want to reset.
Click [Execute] to reset LAN ports.
Click [Close] when finished.

&2Purt LAN Port Reset

=101 x|

Mo.001

i® Port!| ) Port2

Execute | | Cloze |

2.17.6 TX/RX Frequency

Display the RF transmitted frequency and consequently its pair receiving frequency.
(See 2.18 Equipment Setup.)

2.17.7 Sub Band

Sub Band of ODU can be selected

To select Sub Band:

1.

2
3.
4

Click [Sub Band] in Maintenance window.
Select the type of Sub Band in the Sub Band list.
Click [Execute] to carry out the command.

Click [Close] when finished.

2.17.8 TX Mute status

Sub Band - No.001

Sub Band

R -

Evecute | Cloze |

TX power of the ODU is switched off when TX Mute is ON. This should be OFF in normal
operation.

To change the TX Mute status:

1.
2.
3.

Click [TX Mute] in Maintenance window.
Select ON/OFF depending on the desired state.

When you are setting to the opposite NE, you have
to also select TX Release Time in the TX Mute
Release Time list.

Click [Execute] to carry out the command.
Click [Close] when finished.
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" OFF
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2.17.9 Loopback-1

This type loopback is created at the line input of E1..

To set the Loopback-1:

1.

2
3.
4

Click [Loopback-1] in the Maintenance window.

Select ON to activate the loopback.
Click [Execute] to apply the loopback.
Click [Close] when finished.

2.17.10 Loopback-2

This type loopback is created at the line output of E1.

To set the Loopback-2:

1.

2
3.
4

Click [Loopback-2] in the Maintenance window..

Select ON to activate the loopback.
Click [Execute] to apply the loopback.
Click [Close] when finished.
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# CHO1-Loopback -0 x|

Mo 001

f Loophback-1 r Loophack-2 |

—C

ODU
|
:D DU

Laoopkack
(@) O

) OFF

Execute |‘ Cloze

& GHO1-Loopback o m] b1

Mo, 00

r Laoopback-1 r Loopback-2 |

T

pDY

|
S
IDU

Loophack

® oM | (0 OFF

Execite || Cloze
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2.17.11 IF Loopback

This type loopback is created at the IF stage.

1. Click [I F LOOpBaCk] in the Maintenance window. IE LDDPhﬂCkIND."I - No.0O1

NOTE i
Switch ON maintenance mode first before executing IF

Loopback. oDpu

|
2. Select ON to activate the loopback. —ﬁl

3. Click [Execute] to apply the loopback.
4. Click [Close] when finished.

Loopback
gy Cow
Execute Cloze

2.17.12 CW (MOD Carrier) status

When doing frequency measurements, the CW should be turned ON to have an un-modulated
signal. During normal operations this status should be OFF.

To change the CW (MOD Carrier) status:

1. Click [CW (MOD Carrier)] in Maintenance m

window. MO0 Carrier

NOTE & i " OFF

Switch ON maintenance mode first before

executing CW. Execute Close

2. Click ON/OFF depending on desired state.

3. Click [Execute] to carry out the operation.

4. Click [Close] when finished.
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2.17.13 ATPC Manual

Use when an optional transmitting power is required when the ATPC is in operation.
To set the ATPC Manual:

1. Click [ATPC Manual] in Maintenance window.

2. Select the whether to manually turn ON or OFF the ATPL Manual
ATPC manual and the ATPC manual power that will be coon G BER
transmitted indB. 0 i

3. Click [Execute] to activate the new setting. -
anual Fower

4. Click [Close] when finished. I—ZI .

| Cloze

2.17.14 Shift Frequency

The shift frequency function is used to select the type of shift frequency. This function is only
available for 1+0 (4x2M) and 1+0 (20x2M) system configuration

To select Shift Frequency: S Fraguancy.No. 003

1. Click [Shift Frequency] in Maintenance

window. Shift Frequency
2. Select the type of Shift Frequency in the Shift 1008 MHz
Frequency window.

3. Click [Execute] to activate the new setting.

E b Cl
4. Click [Close] when finished. ﬂ g

2.17.15 Antenna Alignment Mode (only available for the specific type of ODU)

The Antenna Alignment Mode function is used for extending the dynamic range of the RX LEVEL
MONITOR (ODU). This function is only available for the specific type of ODU.

To set Antenna Alignment Mode:

1. Click [Antenna Alignment Mode] in =101
Maintenance window. Mo .00
2. Select ON/OEF Arntenna Algnment Mode
i on| O OFF

3. Click [Execute] to activate the new
setting.

Execute | | Claze

4. Click [Close] when finished.
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2.18 Equipment Setup

Main signal, Service signal, ODU and CTRL portion can be monitored and controlled in this
window.

NOTE
If each setting item of "Equipment Setup" is changed when equipment is in-
service mode, the service will be interrupted.

2.18.1 Equipment Configuration window
To open the Equipment Configuration Monitor:
1. Select Configuration - Equipment Setup in the NE-specific menu bar.

2. This window contains the setup information and control for the ODU and the IDU. The
Equipment Setup window is shown below.

EQUIPMENT SETUP
Start Frequency 19309.500 MHz
Stop Frequency 19698.000 MHz
Shift Frequency 1008.000 MHz
UppetLower Upper
Sub Band K
TX Fregquency 19308.500 MHz
R Frequency 18301.500 MHz
Frequency Channel
| Frame ID | 1 |
[ THPowerContral | MTPC |
System Configuration 1+0 {4xZhh)
Transmission Capacity 10mbpsFi
modulation GIPSK
Slat1 PRMS Card
Slot 2 LAN INTFIC-5
LAMN INTFC-S
[2Port LAM == Radio Mapping | Port1-2 SeparatediMain)
PPart LAR P1=P2=2Mhps
2M(E1) Assignment CH1-2
CTRL
ME Mame 1o.001
IP Address 1721802
Mote

Equipment Setup window (1+0 System, 1+1 Hot Stand-by Configuration)
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EQUIPMENT SETUP
No.1 No.2
Start Freguency 13020.500 MHz Start Frequency 13020500 MHz
Stop Freguency 13076.500 MHz Stop Freguency 13076.500 MHz
Shift Frequency 266000 MHzZ Shift Fregquency 266.000 MHz
Uppenlowear Upper UppenLower Upper
Suh Band A Sub Band A
TH Freguency 13020.500 MHz T+ Freguency 13020500 MHz
FX Freguency 12754.500 MHz R+ Freguency 12754500 MHz
Frequency Channel Freguency Channel
| Frame ID | 1 | 1] Frarme ID | Z |
[ T« Power Control | MTPC |
System Configuration 1+1 {Twin Path)
Transmission Capacity 20Mbps
Modulation 16 CIANM
Slot 1 2 INTF C-M{3 2% 200
Slot 2 2M INTFC-5
|
| Setup |
CTRL
ME Mame Moo
IP Address 17218.0.1
Mote

Equipment Setup window (1+1 Twin Path Configuration)
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2.18.2 Setup
To set the ODU and IDU parameters:

1.

Click [Setup] in the Equipment Setup window.

ROI-S05936

Equipment Setup - No.001

Equipment | Slat/LAN |

13301.500 MHz

| StatFrequency | 19309.500 MHz

| StopFrequency | 19652.000 MHz

| ShiftFrequency | 1008.000 MHz

| Upper/Lower | Upper

| SubBand | K.

[ THFrequency | 13309.500] :I MHz
| |

R Freguency

Frequency Channel

| Frarme D | 1

Kl

| T#Power Contol  |MTPC

| Syztem Configuration |

L] L

|Transmission Capacity

| b odulation

[B1a18

L

Execute

Cloze

Setup — Equipment Tab

Equipment Setup - No.001

Equipment  Slot/LAN ]

|Transmission Capacity |

Slat 1

10Mbps(Fix)

Inzerted b odule

| Slot 1

FMMS Card

| Slot 2

| Slot 2

LAM IMTFC-5

B
[

Execute

Cloze

Setup — Slot/LAN Tab
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2. On both Equipment Tab and Slot/LAN Tab of Setup window, the configurable items are
shown and described in the table below:

Equipment TX Frequency — sets the RF transmit frequency and consequently the RF received
frequency of the ODU. If frequency Channel file is previously registered, frequency
setting by Channel name is available. Refer to “Frequency Channel” screen shown
below.

Frame ID — used to synchronize the TX and RX frames of opposing NE’s in the hop.
The frame ID can be set from 1 to 8.

TX Power Control — method used by the ODU for power control functions can be set
here. Either Automatic Transmit Power Control (ATPC) or Manual Transmit Power
Control (MTPC) can be selected.

System Configuration — This function Is available only for 1+1 systems Hot Stand-by
or 1+0 (Expandable) configuration can be set using this function.

Transmission Capacity — the main interface bit rate of IDU can be selected here. The
available rates are 10Mbps, 20Mbps, 40Mbps and 80Mbps. 1+0(4x2M) can be set to
only 10Mbps (FIX). 1+0(20x2M) can be set 10Mbps, 20Mbps, or 40Mbps. 1+0, 1+0
(Expandable) or 1+1 systems can be set using this function.

Modulation— the modulation can be selected here. The available modulations are
PQSK, and 16QAM. When the transmission capacity is set 80Mbps, you can select only
16QAM.

Slot/LAN Slotl — sets the type of the module of Slot1.If this current setting is different from the
inserted module type, you can click the reflect [ ] button and you can set the type to
that of the inserted module.

Slot2 — sets the type of the module of Slot2. If this current setting is different from the
inserted module type, you can click the reflect [ ] button and you can set the type to
that of the inserted module.

LAN INTFC-S — This function is available only when the current setting type of Slot2
is LAN INTFC-S. You can select Radio Mapping and bit rate for each port for 2-Port
LAN interface module. Also the E1 (2Mbps main interface) assignment information is
displayed. If you change the Transmission Capacity, the 2Port LAN setting will be
cleared and you need to set it again.

3. Click [Execute] to apply the new set of values.

CAUTION:
Changing the TX/RX CH will interrupt traffic.
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2.18.3 Frequency Channel

1. Click [Browse] to locate the Channel plan file on the local hard disk.

Frequency Channel D_<|

Import Channel Plan

|D:'\D ocuments and Settings\uzer1sD eskj Browsze. .

Channel Plan

Channel | T Frequency | T Frequency |
Fdd2 000 MHz

CH-2 442,000 MHz  7603.000 MHz

Cancel

2. Select Channel and click [OK], then TX and RX frequency corresponding to the channel will
be set.

Frequency channel file format is csv, including channel name, TX frequency and RX frequency.
Examples

CH-1, 7442.000, 7603.000
CH-2, 7603.000, 7442.000

2.18.4 Editing the NE Name

To edit the NE name:

1. Click [NE Name] in Equipment Setup window.

2. Enter new NE name in the NE Name dialog box. ME Mame
A maximum of 32 characters can be used. “ND.EIml |
3. Click [Execute] to change to new name. ‘ R | | P |

4. Click [Close] when finished.

2.18.5 Editing the Note for NE

To enter an optional description on the current NE:

1. Click [Note] in Equipment Setup window.

2. Enter the optional description for the specific NE in “Mote
the Note dialog box. A maximum of 100 characters ema
can be used in this field

3. Click [Execute] when finished.
4. Click [Close] when finished.

Execute | ‘ Cloze
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2.19 Provisioning
The main interface (MAIN INTFC), SC Assignment, MTPC and ATPC can be set in this window.

2.19.1 Provisioning window
To open the Equipment Configuration Monitor:
1. Select Configuration = Provisioning in the NE-specific menu bar.

2. This window contains the setup information of the MTPC, ATPC, BER Alarm Threshold,
Cluster ALM Setting (Input), AIS Activation, Main Channel Setting, SC Assignment and
LAN INTFC-S. . The Provisioning window is shown below.

MTPC STATUS

MTPC Tx Pover 0de
¥ Threshald -60 dBm

ATPC STATUS

BER ALM THRESHOLD CLUSTER ALM SETTING [INFUT)
High BER 3E-4 Cluster ALM 1 Dizabled
Low BER JE-7 Cluster ALM 2 Dizabled
AIS ACTIVATION

[ AIS Activation Condition | LOF + High BER |

MAIN CHANMNEL SETTING

[ Main Interface Setting |

SC ASSIGNMENT

SC1 sC2 SC3 SC 4
R5-232C RS5-232C YA1(CO) YA1(CO)

LAN INTFC-S
| Fort Setting |

FPort Lsage
Speed & Duplex
Flowe Control
Collision Report
Link Loss Fanwarding

Fortl LAMN == 2M Framing Invalid
Port2 LAM == 2M Framing Irrvalid

Provisioning window (1+0 Configuration)
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MTPC Ti P ower

R Threshald

-ATPC STATUS

ATPC AR

0de

ATPC MM

0dB

¥ Threshold

-60 dBrm

QDU ALM Mode

Hold |

- BER ALM THRESHOLD

- CLUSTER ALM SETTING{INPUT)

High BER

JE-6

Cluster ALM 1

Disahled

Low BER

JE-6

Cluster AL 2

Disabled

- AIS ACTIWATION

SW PRIORITY

T S Friority

Priarity Mo.1

[ 215 Activation Condition |

LOF+High BER |

R S Priority

Priarity Mo.1

~ MAIN CHANNEL SETTING

Main Channel Settin

g |

- SC ASSIGNMENT

S5C1

5C 2

5C 3

5C 4

RS-232C

RES-232C

W10

YATCO)

~LAN INTFC-S

Fart Setting ]

Por Switching

Fottl

P o2

FortUsage

Speed & Duplex

Flowy Control

Collision Report

Link Lo=ss Forwarding

Provisioning window (1+1 Hot Stand-by Configuration)
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No.1 No.2
WMTPC TH Fower -24 dB MTPC TH Power -24 dB
R¥ Threshold -G0 dBm R¥ Threshold -60 dBm
ATPC STATUS
No.1 No.2
I I
BER ALM THRESHOLD CLUSTER ALM SETTING [INPUT]
High BER 3E-4 Cluster ALM 1 Disabled
Low BER 3E-7 Cluster ALM 2 Disabled
AlS ACTIVATION SW PRIORITY
[ AIS Activation Condition | LOF + High BER | | R S Prinrity | Mon-Priority |
MAIN CHANMEL SETTING
[ miain Interface Setting |
SC ASSIGNMENT
S5C1 S5C 2 g5 3 5C 4
RS-232C RE5-232C YA 0) LARL{se)
LAN INTFC-S

Provisioning window (1+1 Twin Path Configuration)

MAIN CHANNEL SETTING

Channel Usage Error Report Reported

AlS Received Report Reparted

AlS Generated Repart Reparted

AlS Received Condition Setting Status

CH USAGE
CHMM Used
cHoz2 Used
CHO3 Used

Main Interface Setting
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When the MTPC is selected over ATPC the buttons on this section will become sensitive and the

MTPC parameters can be set. The MTPC has three (3) parameters:

e MTPC TX Power
e RX Threshold
e Additional Attenuation (Additional ATT) (for PASOLINK " type ODU

The procedure for setting these parameters will be presented in this section.

2.19.2.1 MTPC TX Power

only)

When the MTPC is in operation, the transmission power (dB) can be set using this function.

To set the maximum transmission power in MTPC:

1. Click [MTPC TX Power] in the Provisioning button.

2. Set the power (dB) in the ensuing window. You @ MTPC TX Power | _ O] x|

can either highlight the input field and enter the
dB value using the keypad or use the arrows on
the right-hand corner of the field to increase or MTPC Ti Pavwer

Mo.001

decrease the value shown in the input field. |

0| [<E]

3. Click [Execute] to apply the maximum MTPC | Execite

| | Cloze |

TX power.
4. Click [Close] when finished.

2.19.2.2 RX Threshold

Set the threshold value of the receiving level. When the received level coincides with the preset

value of the TX power threshold is controlled by sending control signals in th
Complementary Overhead (RFCOH).

To set the RX threshold:

e Radio Frame

1. Click [RX Threshold] in the MTPC status section of the Provisioning window.

2. Set the power (dBm) in the ensuing
window. You can either highlight the
input field and enter the dB value using ha.00
the keypad or use the arrows on the R Threshold Level

{& RX Threshold Level(NO.1)" - =] x|

right-hand corner of the field to

-60| [ dBm]

increase or decrease the value shown in

the input field. Execute | |

Cloze ‘

3. Click [Execute] to apply the new
preset value.

4. Click [Close] when finished.
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2.19.2.3 Additional Attenuation (Additional ATT) (only available for the specific type of
ODU)

If the transmission length of the radio section is short, additional span attenuators can be set in the
ODU. The additional attenuation can be set from 0 to 5 dB. This function is only available for the
specific type of ODU.

To set the additional attenuation:

1.
2.

Click [Additional ATT] in the MTPC status section of the Provisioning window.

S?t the attenuation (.dB) n the. ensuing Additional Attenuation - No.001
window. You can either highlight the input

field and enter the dB value using the keypad Additional Attenuation
or use the arrows on the right-hand corner of i
the field to increase or decrease the value EI de

shown in the input field

Click [Execute] to apply the attenuation. @ M

Click [Close] when finished.

2.19.3 Automatic Transmit Power Control (ATPC) Status

When the ATPC is selected over MTPC the buttons on this section will become sensitive and the
ATPC parameters can be set. The ATPC has five (5) parameters:

ATPC (MAX) (TX MAX Power)

ATPC (MIN) (TX MIN Power)

RX Threshold

Additional Attenuation (Additional ATT) (only available for the specific type of ODU)
ODU Alarm Mode

The procedure for setting these parameters will be presented in this section.

2.19.3.1 ATPC (MAX) (TX MAX Power)

When the ATPC is in operation, the maximum transmission power (dB) can be set using this
function.

To set the maximum transmission power in ATPC:

1.
2.

Click [TX MAX Power] in the ATPC status section of the Provisioning window.

Set the power (dB) in the ensuing window. You can either highlight the input field and
enter the dB value using the keypad or use the arrows on the right-hand corner of the field
to increase or decrease the value shown in the input field.

Click [Execute] to apply the & ATPC TX MAX Power{No.1) B =]
maximum ATPC TX power. .
o.001
Click [Close] when finished. ATPC T MAK Povwver
| 0| [dE]
Execute | | Cloze ‘
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2.19.3.2 ATPC (MIN) (TX MIN Power)

When the ATPC is in operation, the minimum transmission power (dB) can be set using this
function.

To set the minimum transmission power in ATPC:

1. Click [TX MIN Power] in the ATPC status section of the Provisioning window.

2. Set the power (dB) in the ensuing window.
You can either highlight the input field and ATPC TX MIN Power - No.00O1

enter the dB value using the keypad or use ATPC TS MIN Paver
the arrows on the right-hand corner of the
field to increase or decrease the value shown e
in the input field.
3. Click [Execute] to apply the minimum Evecute Clase
ATPC TX power. Q Q

4. Click [Close] when finished.

2.19.3.3 RX Threshold

Set the threshold value for the receiving level. When the received level coincides with the preset
threshold value, the TX power is controlled by sending control signals in the Radio Frame
Complementary Overhead (RFCOH).

To set the RX threshold:
1. Click [RX Threshold] in the ATPC status section of the Provisioning window.

2. Set the power (dB) in the ensuing window. RX Threshold Level - No.001

You can either highlight the input field and
enter the dB value using the keypad or use R Threshold Level

the arrows on the right-hand corner of the =
= gm

field to increase or decrease the value shown
in the input field.

3. Click [Execute] to apply the new preset m M

value.

4. Click [Close] when finished.

2.19.3.4 Additional ATT (Attenuation) ( (only available for specific type of ODU)

If the transmission of the radio section is short, additional span attenuators can be set in the ODU.
The additional attenuation can be set from 0 to 5 dB.

To set the additional attenuation:
1. Click [Additional ATT] in the ATPC status section of the Provisioning window.

2. Set the attenuation (dB) in the ensuing

window. You can either highlight the input Additional Attenuation - Mo.001

field and enter the dB value using the keypad - )
or use the arrows on the right-hand corner of Additional Attenuation

the field to increase or decrease the value |—1:| @

shown in the input field

3. Click [Execute] to apply the attenuation. _— Close

4. Click [Close] when finished.
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2.19.3.5 ODU Alarm Mode

When the ODU loses communication with the IDU due to a failure of some sort, the response of
the ODU can be preset using this function. Since the control function of the TX power is in the
IDU, the ODU will be cut-off from this control when communication between ODU and IDU is
disrupted. In this case, the ODU either mutes the TX or holds the current TX power, depending on
the preset ODU ALM mode.

To set the ODU Alarm mode:

1.

Click [ODU Alarm Mode] in the ATPC status & ODU Alarm Mode N [l
section of the Provisioning window. Mo |:||:|1.

Select the action of the ODU in case of IDU 00U Alarm Mode

communication disruption. For ATPC, MAX @ i ) MAX Y Hold

Hold, MIN Hold or Hold mode is available.

Click [Execute] to apply the new setting. Execute ‘ | s |

Click [Close] when finished.

2.19.4 BER Alarm Threshold

The BER in the system monitors the DMR section. The figure below illustrates these sections.

2.19.4.1 High BER

To set the threshold for High BER:
L.

2
3.
4

& BER ALM Threshold =10 %]
Click [High BER] in the Provisioning window. P 001

High BER:

) 3E-4 (@ 3E5 ) 3E6

Select the preset BER value that will trigger.

Click [Execute] to apply the new setting.

Click [Close] when finished. SEE || el

2.19.4.2 Low BER
To set the threshold for Low BER:

1.

Click [Low BER] in the Provisioning
window.

# BER Alarm Threshold =101 %]

o001

Select the preset BER value that will
trigger.

Loy BER
W 3E-5 | (0 3E7 (U 3E8 0 3E-9 (' Early Warning

Click [Execute] to apply the new
setting. Execute ‘ | Cloze

Click [Close] when finished.
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2.19.5 Cluster ALM Setting (Input)

This function enables or disables the Cluster Alarm setting.

1. Click [Cluster ALM 1/2] in the &Gluster ALM Settingﬂnpuf: _ IDIEI
Provisioning window. '

Ma.001

2. Select Enabled/Disabled depending on | Cluster ALM 1

the desired state. {®) Enabled ) Disabled

3. Click [Execute] to apply the new

setting. Execlte || Close

4. Click [Close] when finished.

2.19.6 AIS Activation

This function is used to set the AIS Activation Condition and AIS Activation Delay Time.

2.19.6.1 AIS Activation Condition

This function allows you to set whether AIS signal for main 1.5MB is by LOF, High BER or both
alarm conditions.

To set the AIS Activation Condition:

1. Click [AIS Activation Condition] button
in the Provisioning window.

& AIS Activation Conditior =101 x|
Mo 001

2. Select LOF/LOF or High BER depending [ A&I% Activation Concition
on the desired state. @ LOF () LOF+High EER

3. Click [Execute] to apply the new setting.

Execute | | Cloze

4. Click [Close] when finished.

2.19.7 SW Priority

2.19.7.1 TX SW Priority
The TX SW priority defines the channel that will be selected by the TX switch when both channels

are normal. :

{3 TX SW Priority -] x|
Priority No.1: Priority is given to No.l channel. "
Non-priority: There is no priority. T3 S\ Priority

This function is available for 1+1(HS) system only. ® riorty NoA | ' Hon Priorty

Execute | ‘ Cloze |

2.19.7.2 RX SW Priority

The RX SW priority defines the channel that will be selected by the RX switch when both channels
are normal.

Priority No.1: Priority is given to No.1 channel.

Non-priority: There is no priority. R Sy Pririty

This function is available for 1+1 system only. (81 Priorty NoA_| {2 Non Priotty

Execite | ‘ Claze |
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2.19.8 Main Interface Setting
2.19.8.1 Channel Usage Error Report

This function is to enable or disable the Channel Usage Error Report function. This error is
reported when 2MB bipolar signal is inputted into the channel chosen “Not Used”.

To set the Channel Usage Error Report:

1. Click [Channel Usage Error] in
the Provisioning - Main Interface
window. Ma.001

Channel Usage Error Report

Y Report i1 Mot Report

&Ghannel Usaee Error Report o ] B

2. Select Reported/Not Reported
depending on the desired state.

3. Click [Execute] apply the new Execute H Close
setting.

4. Click [Close] when finished.

2.19.8.2 AIS Received Report
This function is to enable or disable the AIS Received Report function.

To set the AIS Received Report:

1. Click [AIS Received Report] in the
Provisioning - Main Interface window.

& AIS Received Repurtifé o [

Mo 001
AlS Received Report

2. Select Reported/Not Reported depending on

the desired state.
@' Repart D Mot Repart

3. Click [Execute] apply the new setting.

Execute | | Cloze

4. Click [Close] when finished.

2.19.8.3 AIS Generated Report

This function is to enable or disable the AIS Generated Report function.

To set the AIS Generated Report:

1. Click [AIS Generated Report] in the A3, Generated Report - No.001

Provisioning - Main Interface window. 215 Generated Report

2. Select Reported/Not Reported depending on
the desired state.

" Mot Reported

3. Click [Execute] apply the new setting.

4. Click [Close] when finished. Execute _ G|
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2.19.8.4 AIS Received Condition Setting
This function enables to set the type of AIS Received Condition.

To set the AIS Received Condition Setting:

1. Click [AIS Received Condition] in the Provisioning - Main Interface window.

& AIS Received Condition Setting ]
Mio.001
Als Received Condition Setting

i a0 Status

| Execute H Cloze |

2. Select Alarm/Status depending on the desired state.
3. Click [Execute] to apply the new setting.
4. Click [Close] when finished.

2.19.9 SC Assignment
This function is for displaying the assigned interface type {LAN or RS-232C} of the available four
user channels (DSC), and sets the type of directional interface for SC3 and SC4.

2.19.9.1 Direction (for 1+0 (Expandable) and 1+1 system only)
To set the type of directional interface for SC3 and SC4:

1. Click [Setting] in the SC Assignment section of the Provisioning window.

&SG Assignment =10] =]
M. 00
SC3
CIRYER! :Co-Directional(Con A1 (Contra-Directionall COMTRA)
SC4
vt (Co-Directional(CO0 11 (Contra-Directionall COMTRA)
Execite | | Cloze

2. In the ensuing window, you will be able to select the type of directional interface for SC3
and SC4.

3. Click [Execute] to apply the new setting.
4. Click [Close] when finished.
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2.19.10 LAN INTFC-S

£ Port Settine o ] |
Mo, 001
LAM INTFC-5
| Part Switching [P1-2 = Enabled -
Port1 Port2
Lisage Used ~ Usage Used ~
Speed & Duplex 10M-HALFCMDID - Speed & Duplex 10M-HALF DI -
Flowe Contraol On ~ Flow Cortriol OFF ~
Colligion Repart hot Report - Collizion Report Mat Report 7
Link Loss Forwwarding Link Loss Forvarding
Port1-2 LAN == 2M Framing | PCM-31C(FAS+CRC) -
| Execute | | Close |
Port Setting (LAN INTFC-S)
Port Port Switching — set the Port Switching when 2-Port LAN interface is used as {Port1-2
Setting Shared/1 Port Only (Main) or Port1-2 Shared/1 Port Only (SC)}.

Usage — specify the usage of each port.

Speed & Duplex — set the type of the speed and the duplex of each port. The available
types are AUTONEG (AUTO-MD1/MDIX),10M-HALF(MDI),10M-
FULL(MDI),100M-HALF(MDI),100M-FULL(MDI),10M-HALF(MDIX),10M-
FULL(MDIX),100M-HALF(MDIX) and 100M-FULL(MDIX).

Flow Control — specify the Flow Control of each port.

Collision Report — set the status of each port to report when some collision occurs.
Link Loss Forwarding- set enable of Link Loss Forwarding of each port.

Slot/LAN Portl-2 LAN >> 2M Framing — set the type of 2M Framing. This parameter is
available when the following conditions are true 2-Port LAN >> Radio Mapping =
Port1-2 Shared / 1 Port Only (Main) and 2Port LAN = 2Mbps in Equipment Setup
window.

Portl LAN >> 2M Framing — set the type of 2M Framing. This parameter is available
when the following conditions are true: {2-Port LAN >> Radio Mapping = Port1-2
Shared / 1 Port Only (Main) and 2Port LAN = 2Mbps}, or {2-Port LAN >> Radio
Mapping=Port1-2 Shared / 1 Port Only (SC) and 2Port LAN=2Mbps} in Equipment
Setup window.

Port2 LAN >> 2M Framing — set the type of 2M Framing This parameter is available
when 2-Port LAN >> Radio Mapping = Port1-2 Separated (Main) and 2Port LAN
=2Mbps in Equipment Setup window.
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2.20 Link Performance Monitor

The following performance items can be monitored according to the parameters expressed in the
G.826 recommendation:

0 Out of Frame Second (OFS) — the total number of seconds the "out of frame" condition
is generated in 15 minute-blocks.(OFS is applied to the Total only)"

o Errored Second (ES) — the cumulative time in which more than one B1 error pulse per
second was detected

a Severely Errored Second (SES) — the cumulative time in which the BER of one-second
period exceeded 10E-3.

0 Unavailable Second (UAS) —the cumulative time in which the unit remained inoperative
o Background Block Error (BBE) - the sum of the B1 background block error

Red color in Performance Monitor window indicates the occurrence of performance items
exceeding the threshold value. The threshold values can be set in Threshold window. The detailed
daily performance data can be viewed by clicking [Detail].

2.20.1 Viewing Summary Link Performance Monitor
To view Summary Link Performance Monitor:

Click Performance Monitor - Link Performance Monitor in the NE-specific menu bar of the
target NE that you intend to monitor.

& Link Performance Monitor, - Mo.001

2
BER[DMR]
[ BER HEEEE
G.826
Detail Threshold
Latest Histany 18min Day
1amin Day 15min Day Qceour Recover Qceour Recover
QFS 1] 1] Marmal | Narmal 4900 e 11] f9534 gal
ES 1] 1] Marmal | Marmal 400 e 11] f9534 gal
SES I 1] Marmal | Narmal Q00 a0 fAa534 (a1l
LAS I 1] Marmal | Marmal Q00 an 65534 G50
BBE I 1] Marmal | Marmal 919965 4919496 919965 4919496
Ready

Summary Link Performance Monitor window
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2.20.2 Threshold Setting
To set the threshold values:

1. Click [Threshold] in the Summary Link Performance Monitor window

Link Performance Monitor Threshold - No.001

Set Threshald
15 mik Day
Oecur Recover Qecur R ecowver
OFs | 0| 50| 65534 E50
ES | ann| au| 55534| B50
SES | auu| 90| 55534| B0
&S | SIZIIZI| su| 85534| B50
BEE | 919955| 91995| 919955| 91995
Execute Cloze

Summary Link Performance Monitor Threshold

2. Select the performance item that is to be configured in the table shown above. The G.826
measuring parameters become available for setting when selected. The arrow buttons on
the left-hand side of the field indicate this.

3. Set the value when the alarm occurred (Occur) and when the alarm was resolved
(Recover) in the appropriate field. The measuring parameters will initiate an alarm status
indication when it reaches the alarm occurrence (occur) value or an alarm clear status
when it reaches the resolution (recover) value set in the threshold table.

4. Click [Execute] to activate the new settings.

5. Click [Close] when finished.
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2.20.3  Link Performance Monitor (1day / 15 min. Data) window
To view the 1day Data:

1. Click [Detail] in Summary Link Performance Monitor window.

Upload File  Wiew
(Refresh) 4[»,3 /F
/ OF5 ES SES Las BEE

Save 2i1/2002

1)31 /2002 Irvalid Ireealid Irvalid Irvalid Ireealid

1/30/2002 1 ] 0 26369 0

1/29/2002 Irvalid Ireealid Irvalid Irvalid Ireealid

1j2ar2002 Imvalid Ireealid Invalid Imvalid Ireealid

1)27 /2002 0 0 0 0 0

1j26/2002 Imvalid Ireealid Invalid Imvalid Ireealid

1/25/2002 Invalid Treealid Invalid Invalid Trevealid

Link Performance Monitor (1day Data) window (Total)

To view the 15-min. Data:

2. Click the target date in Link Performance Monitor (Daily Data) window to display the
detailed 15-minute performance data.

|5 &
[ Date | 113072002 |
OF5 |Es SES UAS BEE |~

2:45 PM - 3:00 PM 0 0 0 0 0
3:00 PM - 3:15 PM 0 0 0 0 0
3:15 PM - 3:30 PM 0 0 0 0 0
3:30 PM - 3:45 PM 0 0 0 0 0
3145 PM - 4:00 PM 0 0 0 0 0
4:00 M - 4:15 PM 0 0 0 0 0
4115 PM - 4:30 PM 0 0 0 0 0
4:30 PM - 4145 PM 1 0 0 269 0
4:45 PM - 5:00 PM 0 0 0 200 0
500 FM - 5:15 PM 0 0 0 200 DJ
5:15 PM - 5:30 PM 0 0 0 900 0
5:30 PM - 5:45 PM 0 0 0 200 0
5:45 FM - 6:00 PM 0 0 0 200 0
£:00 PM - 6:15 PM 0 0 0 500 0 v

Link Performance Monitor (15-min. Data) window

3. The data can be saved in text format by clicking then save icon. It can be refreshed by
clicking the upload (refresh) icon.
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Remote Network Monitoring (RMON) function can monitor the signal through the LAN port, both
LINE-side (the port on the NE) and DMR side. RMON can count the number of received or

transmitted packets and packets errors. These items are then displayed in the PNMT.

The following RMON items can be monitored:

RMON

from 64 octets to 1536 octets.

RX Unicast Pkts — the total number of unicast packets received. This item measures

broadcast address. This item measures from 64 to 1536 octets in length.

RX Broadcast Pkts — the total number of packets received that were directed to the

multicast address. This item measures from 64 to 1536 octets in length.

RX Multicast Pkts — the total number of packets received that were directed to a

RX Pause Pkts — the total number of packets received that were paused.

item measures from 64 to 1536 octets in length.

RX CRC Errors — the total number of packets received that detected FCS error. This

This item measures from 64 to 1536 octets in length.

RX Align Errors — the total number of packets received that detected Alignment error.

This item measures from 64 to 1536 octets in length.

RX Symbol Errors — the total number of packets received that detected Symbol error.

octets in length.

RX Undersize Pkts — the total number of good packets received that were less than 64

less than 64 octets in length.

RX Fragments — the total number of packets (Including bad packets) received that were

octets in length.

RX Pkts 64 — the total number of packets (Including bad packets) received that were 64

were between 65 and 127 octets in length.

RX Pkts 65-127 — the total number of packets (Including bad packets) received that

were between 128 and 255 octets in length.

RX Pkts 128-255 — the total number of packets (Including bad packets) received that

were between 256 and 511 octets in length.

RX Pkts 256-511 — the total number of packets (Including bad packets) received that

were between 512 and 1023 octets in length.

RX Pkts 512-1023 — the total number of packets (Including bad packets) received that

were between 1024 and 1536 octets in length.

RX Pkts 1024-1536 — the total number of packets (Including bad packets) received that

1537 and 1916 octets in length.

RX Pkts 1537-MAX — the total number of good packets received that were between

longer than 1537 octets.

RX Jabbers — the total number of packets received (Including bad packets) that were

from 64 to 1916 octets in length.

TX Unicast Pkts — the total number of unicast packets transmitted. This item measures

broadcast address. This item measures from 64 to 1916 octets in length.

TX Broadcast Pkts — the total number of packets transmitted that were directed to the

multicast address. This item measures from 64 to 1916 octets in length.

TX Multicast Pkts — the total number of packets transmitted that were directed to a

TX Pause Pkts — the total number of packets transmitted that were paused.

TX Total Collisions — the total number of collisions when it is transmitting.
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NOTE:

If an item causes overflow, “+” will be shown in front of the
number.

If an item is invalid, “*”” will be shown in front of the number.
When the total number is imperfect, it will be shown as invalid.

During maintenance mode, an item will be shown with
maintenance color (yellow as default).

2.21.1 Viewing RMON LAN INTFC-S [Current]

This window contains the latest 15-minute data (15-min) and to the current day’s total data (Daily)
for all RMON items.

To view RMON LAN INNTFC-S [Current] Monitor:

Select Performance Monitor > RMON LAN INTFC-S [Current] in the NE-specific menu bar
of the target NE that you intend to monitor.

¢ LAN INTFC-S RMON[Current] - No.001 Pasolink Mx

File
S
FPaort1 LINE Fortl DMRE FPort2 LINE FPort2 DR
15-min Daily 15-min Diaily 158-min Diaily 18-min Daily
R Unicast Pkis 14545990 1801153770 1079417 *215490212 4515530 *495026093 4515482 *B14700326
R Broadcast Pkis 0 *0 0 *0 a *0 0 *0
R Multicast Pkis 0 *0 0 *0 a *0 0 *0
R¥ Pause Plds 0 *0 407113 *&1107082 a *0 409192 *44944300
R¥ CRC Errars 0 *0 0 *0 a *0 0 *0
R Align Errors 0 *1 0 *
R Symhbol Errors 0 *N 0 *
F¥ Undersize Pkis 337 40764 a *0
RX Fragments TET11 *10573100 0 *0 1] *0 0 *0
R Phis 64 14546012 1801153792 1486528 *2EE597294 4515530 495926093 4924674 *HEH644628
R Pkts 65-127 0 *0 0 *0 1] *0 0 *0
R Pkis 128-255 0 *0 0 *0 1] *0 0 *0
R Phts 256-511 0 *0 0 *0 1] *0 0 *0
R Pkt 512-1023 0 *0 0 *0 i *0 0 *0
R Pkts 1024-1536 0 *0 0 *0 a *0 0 *0
R Phis 1537-MAK 0 *0 0 *0 a *0 0 *0
R Jahbers 0 *0 0 *0 a *0 0 *0
T Unicast Pkis 1073713 *214808148 4503754 *5BE00316R 4515481 *B14700322 41515486 *495926038
TH Broadeast Pkis 0 0 0 *0 a *0 0 *0
TH Multicast Pkis 0 *0 0 *0 a *0 0 *0
TH Pause Pkis 0 * £995 *g51084 106956 *1738331 0 *0
Tx Total Callisions 95427 *12042834 1] *0
JReady

RMON LAN INTFC-S [Current] window

This data can be refreshed by selecting File > Refresh menu or clicking on Refresh icon.
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2.21.2 Viewing RMON LAN INTFC-S [15-min]
This window contains the total 15-minute data in 24 hours for all RMON items.
To view RMON LAN INTFC-S [15-min] Monitor:

1. Select Performance Monitor > RMON LAN INTFC-S [15-min] in the NE-specific menu
bar of the target NE that you intend to monitor.

% LAN INTFC-5 RMON[15-min Data] - No.001 Pasolink Mx

Flle Select Sort
423
Portl LIME A
R Unicast Pkks | R¥ Broadcast Pkts | R Multicast Pkks R¥ Pause Pkks R CRC Errors R¥ Align Errors | R
1211612004 16:45-16:30 109268641 0 o a a 0
1211612004 16:30-16:15 109274534 0 o a a 0
12116f2004 16:15-16:00 109425139 o a u] u] o
12116f2004 16:00-15:45 109262249 0 0] u] u] 0
1211612004 15:45-15:30 109261636 0 u] u] u] 0
1211612004 15:30-15:15 109360209 0 o a a 0
12116f2004 15:15-15:00 109391524 o a u] u] o
120 16/2004 15:00-14:45 109402651 o a u] u] o
12116f2004 14:45-14:30 109419574 0 0] u] u] 0 b’
< >
|Ready File Size : 94303 Bytes

RMON LAN INTFC-S [15-min] window

2. This data can be saved by selecting File > Save All Data menu or clicking on Save All Data
icon. The default file name that it will be saved to is “15min-s.rmon”.

3. This data can be refreshed by selecting File 2 Reload menu or clicking on Reload ﬁ' licon.

4. This data can be sorted by port or Item by selecting Sort = Port Sort or Item Sort menu.

5. The viewing RMON items can be selected with the Select window.

To view the Select window:

Select Select = Select menu.
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Select [kem
LINE DMR
I ltem Part1 ﬂ Portz E Fart1 ﬂF’DrtEﬂ
01 | R Unicast Pkts v B v B
02 | R Broadcast Pkls v B v B
03| R Multicast Pkts v B v B
04 | R Pause Pkts v B v B
05| R CRC Emars v B v B
06 | R dlign Erors v [ [ [
07 | R Symbol Erors v B B [
028 | R Undersize Pkts v B B [
09| R Fragments v [ [ B
10| B« Pkis 64 v [ v [
11| B« Pkts B5-127 v [ v [
12| B« Pkis 128-255 v [ v [
13| B« Pkts 256-511 v [ v [
14| B« Pkts 512-1023 v [ v [
15| B« Pkis 1024-1536 v [ v [
16| B Pkis 1537 Mk v [ v [
17| R Jabbers v B v B
18| T Unicast Pkts v B v B
19| T Broadcast Pkts v B v B
20| T Multicast Pkts v B v B
21| T¥ Pause Pkts v B v B
22 | T Total Callisions v B B [
ok |

RMON LAN INTFC-S [15-min] Select window

ROI-S05936

You can select/deselect the items that you want to be shown by clicking the list ] icon and
selecting from the pull down menu {Select All / Clear All}, Package control for all the item(s) can
be carried out for individual Port.
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2.21.3 Viewing RMON LAN INTFC-S [Daily]
This window contains the daily data in 7 days for all RMON items.
To view RMON LAN INNTFC-S [Daily] Monitor:

1. Select Performance Monitor > RMON LAN INTFC-S [Daily] in the NE-specific menu
bar of the target NE that you intend to monitor.

) LAN INTFC-S RMON[Daily Data] - No.001 Pasolink Mx M=
File Select Sort
G
Portl LINE
R¥ Unicast Pkks | R¥ Broadcast Pkts | B Multicast Pkts | R Pause Pkks R¥ CRC Errors R¥ align Errors | R

12j15/2004 *3543300583 *0 *0 *0 *0 #0

12i14/2004 *1997EZ559 * *0 * *d *

£ >
Ready File Size : 2053 Bytes

RMON LAN INTFC-S [Daily] window

1. This data can be saved for all items by selecting File > Save All Data menu or clicking on
Save All Data &l icon. The default file name is “daily-s.rmon”.

2.  This data can be refreshed by selecting File > Reload menu or clicking on Reload ﬂ licon.

3. This data can be sorted by port or Item by selecting Sort = Port Sort or Item Sort menu.

4. The viewing RMON items can be selected with the Select window.

To view the Select window:

Go to Select > Select menu.
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LAN/INTFC-5 RMON Select[15-min Data] - No.001 Pasolin...

Select [kem
LINE DMR
I ltem Part1 ﬂ Portz E Fart1 ﬂF’DrtEﬂ
01 | R Unicast Pkts v B v B
02 | R Broadcast Pkls v B v B
03| R Multicast Pkts v B v B
04 | R Pause Pkts v B v B
05| R CRC Emars v B v B
06 | R dlign Erors v [ [ [
07 | R Symbol Erors v B B [
028 | R Undersize Pkts v B B [
09| R Fragments v [ [ B
10| B« Pkis 64 v [ v [
11| B« Pkts B5-127 v [ v [
12| B« Pkis 128-255 v [ v [
13| B« Pkts 256-511 v [ v [
14| B« Pkts 512-1023 v [ v [
15| B« Pkis 1024-1536 v [ v [
16| B Pkis 1537 Mk v [ v [
17| R Jabbers v B v B
18| T Unicast Pkts v B v B
19| T Broadcast Pkts v B v B
20| T Multicast Pkts v B v B
21| T¥ Pause Pkts v B v B
22 | T Total Callisions v B B [
0k

RMON LAN INTFC-S [Daily] Select window

ROI-S05936

You can select the items that you want to be shown by clicking on the list [y} button and selecting
from the pull-down menu {Select All / Clear All}. Package control of all the item(s) can be carried

out for individual Port.
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2.22 NE Stored Log

NE Stored Log window displays the date/time when the event data was received, item, and status.

2.22.1 NE Stored Log monitor

1.

Click on [NE Stored Log] in the NE-specific menu bar of the target NE that you intend to
monitor.

A message window showing the progress of the uploading of the NE Stored Log data will
appear on the screen. Wait until the PNMT finishes the uploading of the data. The
progress window will automatically close once the uploading is completed.

The NE Stored Log View will be displayed. The event log is presented in a table form
showing the date of the event, the item that triggered the event and the status change.

Sorting is possible for every column in NE Stored Log window.
The date shown in the NE Stored Log window will be the format set up by OS.

The data can be refreshed by clicking on the upload (refresh) icon.

Status

Tokal Events : 300 File Size : 30300 Bytes
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2.23 Version Tab

The inventory information of the equipment can be viewed using this function.

2.23.1 Version Monitor

To display the version of the equipment:

1. Select the Version tab in PNMT main window.

ROI-S05936

2. The Version window shows the Code No., Date of Manufacture, Serial No., Hardware
Type (for ODU only) and Software Version of the equipment.

opu
Code Mo HO3525
Date of Manufacture 22002004
Serial Mo, no103z2
Hardware Type 1.00
Software Wer. 013
DU
Code Mo, H13504
Date of Manufacture 212312004
Serial ko 0123445
Software Wer (CTRL) 1.0.2
Software Yer (CPLUGUBY test
Version window (1+0 Configuration)
oDy
Mo Mo
Code Mo, HO350A HO3504
Diate of Manufacture 17952004 11952004
Serial Ba. o002z no10zo
Hardware Type 1.00 1.00
Software Wer. 0.04 0.04
[11])
Sy LIMIT
Code Mo, H1314A
Diate of Manufacture 452004
Serial Mo, 000011
Software Yer (CTREL) 1.0.7
Software Yer. (CPLUSLIBN 1.00
MO URIT Mo WD URIT Mo 2
Code Mo, H1322A H13228
Date of Manufacture 113002004 103062004
Serial Mo, 00400 o040

Version window (1+1 Configuration)
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2.24 License import

2.24.1 License import
To update the license file:

1. Go to Help = License in menu bar on PNMT main window.

2. Import License Wizard will appear on screen. Click [Next] to continue.

Import License

Welcome to the Import License

To continue, click Mext.

ROI-S05936

= Back || et = | |

Cancel
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3. Click [...] to locate the new license key file.

Import License

Select License File
Please select file (Default file name iz "License key™)

4. Indicate a License key file (i.e. License.key) that will be associated to PNMT. Select a
License key file and click [Open] to continue.

s Open X|

=L I N I TE ] S

oo [es |
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5. After verifying the path to License key file is correct, click [Next] to proceed.

Import License

Select License File
Please =zelect file (Default file name is "License key™

COPMMS configiLicense key

6. The progress of checking license file will be displayed. If no error is encountered in checking
of the license file, click [Next] when the button becomes available.

Import License

Check License File
Load and check the new License.
Thiz may take zeveral seconds.

-176 -



ROI-S05936

7. Verify the contents of license that you applied.

Import License ll
Import License Limits
Fallovwving lirmits were imported from file ©
Hey | “alue
Licenze Type Trial
Period of Yalidity 06112005
| = Back || et = | | Cancel

8. Click [Finish] in ensuing window to complete applying license.

Import License ll

Import License has done

To processing is performed, click Finish.

= Back || | | Cancel
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Appendix A: IP Network Settings

ROI-S05936

In IP Network Setting, the set item of each NE is different. A set item of each NE is
depend on selecting CTRL Type.

CTRL Type

(General) Category Input Item
General CTRL Type
Radio/NE1 IP Address
Subnet Mask
LAN
PNMS Connection
Root NE I V11
(PNMS LAN IP Address
Connection: LAN) PNMS Subnet Mask
IP Address (Fix)
V11 (Disable) Subnet Mask (Fix)
Speed (Fix)
Routing Default Gateway
General CTRL Type
Radio/NEL/LAN IP Address
Subnet Mask
PNMS Connection LAN
Root NE V11l
(PNMS LAN (Disable) ETAddress
Connection: V11) PNMS Subnet Mask
IP Address (Fix)
V11 Subnet Mask (Fix)
Speed (Fix)
Routing Default Gateway
General CTRL Type
Normal NE Radio/NEL/LAN IP Address
Subnet Mask
Routing Default Gateway
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1. In Category - General and select two CTRL Type.

& IP Metwork Setting

Mo.001
_w_ - - General
| “RadioMETLERN |
T Rodng AT TCTRL Type
CTRL Type: | Marmal MNE - |
/ ~Port Information
Port Port | IPaddress | Subnet Mask
c FadioMETLAN  0.0.00 255 255 255192
ategory W11 1921681253 2552552550
Category
|
Execute | | Close

The NE will appear as follows according to configuration.

e Root NE
The nearest NE to PNMS configure as Root NE

e Normal NE

The rest of all NE (except above mentioned) is Normal NE.

2. The Port Category item changes according to CTRL Type.

General | General
RadichE1

CTRL Type = Root NE

Port
Category

FadioMETLARN

General

CTRL Type

Raouting

CTRL Type: | Marmal ME v

TRL Type = Normal NE
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3. Set and select Port category. The right hand screen will change according to the
selected item in Category.

e |P Address & Subnet Mask

The following items are set to each Port

4, Set Default Gateway.

PHS Connection: |LAN > |
LA
P Address: 0.0.0.0 |
Subnet Mask: |255.255.255.1 92 |
W11
IP Address:
Subnet Mask:
Speed:
PNMS
Metnsark
P Address: 0000 |
Subnet Mask: 255 255 255 192 |
HOLC
hdode: Slave

Radio/NE1 or Radio/NE1/LAN

Genetal
RadioMET
PrMS
Rowting

Routing
Default Gateveay

P Address: 0.0.0.0

Routing

5. Click [Execute] button to activate the IP Networking setting.

NOTE:

When executing IP Network Setting communication will
be lost when the Control module re-initialises to the new
system configuration. This WILL NOT affect the wireless
link. During this time PNMT connection to the NE will be
lost but will automatically be reconnected after the
Control module resets.
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< Sample Network Configuration >

NOTE

Only SYNC or LAN back to back NMS connection
between Mx is supported. ASYNC back to back NMS
connection used in multi-drop is NOT supported.
Therefore, connections using NE2 port on the Mx should
be avoided. In case of multi-drop connection, LAN port
can be used together with LAN Hub/Switch.

NOTE

It is necessary to set in the fourth octet of IP address in
both ends NE of SYNC connection and both ends NE of
radio opposition where becomes the pair of the odd
number and the even number respectively.

NOTE

The Mx network which is supported for Auto discovery,
Only one subnetwork can be configured (subnetwork is
not dividable) and support maximum 62 NEs. Therefore,
mixing of other equipments to Mx network should be
avoided.
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1. Network configuration for SYNC Back-back NMS connection

L
PNMS \

—
Router

Ty
\

192.168.0.10
255.255.255.0

Root NE

192.168.0.1
255.255.255.0

255.255.255.192

172.18.0.1

ROI-S05936

255.255.255.192

/’255.255.255.192 NE1 NE1
SYNC /
No.0 %0.03 (] [Nooa
Normal NE Normal NE Normal NE
172.18.0.2 172.18.0.3 172.18.0.4

255.255.255.192

PNMT (5

CTRL Type
NE (General) Category Item Name Input data
Radio/NEL/LAN IP Address 172.18.0.1
Subnet Mask 255.255.255.192
IP Address 192.168.0.10
No.01 | Root NE PNMS ”
(PNMS Connection: V11) Subnet Mas 255.255.255.0
Speed 19200
Routing Default Gateway 192.168.0.1
Radio/NEL/LAN IP Address 172.18.0.2
No0.02 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.3
No0.03 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.4
No.04 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
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2. Network configuration for LAN Back to back NMS connection

(i
PNMS \

Router -

\

192.168.0.1

192.168.0.10
255.255.255.0
\

172.18.0.1
/’255.255.255.192

LAN

_ ( 1 No.04
Root NE Normal NE Normal NE Normal NE
172.18.0.2 LAN 172.18.0.3 172.18.0.4

255.255.255.192

255.255.255.0

255.255.255.192

PNMT i:

255.255.255.192

CTRL Type
NE (General) Category Item Name Input data
Radio/NEL IP Address 172.18.0.1
Subnet Mask 255.255.255.192

No.01 | Root NE PNMS IP Address 192.168.0.10
(PNMS Connection: LAN) Subnet Mask 255.255.255.0
Routing Default Gateway 192.168.0.1
Radio/NEL/LAN IP Address 172.18.0.2

No.02 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.3

No.03 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.4

No.04 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
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3. Network configuration for LAN Multi-drop NMS connection

192.168.0.1
255.255.255.0

PNMT

3

ROI-S05936

No.04

192.168.0.10 172.18.0.1 NE1
255.255.255.0 255.255.255.192
NE1
( 1 No.O SYNC ( 1
- L)
ormal NE Branch NE
LAN
172.18.0.2
255.255.255.192 172.18.0.3

255.255.255.192

Normal NE

172.18.0.4
255.255.255.192

255.255.255.192

U LA { [ ]
U AN __[No.05 No.06
B
LAN L J
Normal NE Normal NE
172.18.0.5 172.18.0.6

255.255.255.192

LAN _IN0.07 ( 1 No.08
LAN Normal NE Normal NE
172.18.0.7 172.18.0.8
255.255.255.192 255.255.255.192
CTRL Type
NE (General) Category Item Name Input data
Radio/NEL IP Address 172.18.0.1
Subnet Mask 255.255.255.192
No.01 | Root NE PNMS IP Address 192.168.0.10
(PNMS Connection: LAN) Subnet Mask 255.255.255.0
Routing Default Gateway 192.168.0.1
Radio/NELLAN IP Address 172.18.0.2
No0.02 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NELLAN IP Address 172.18.0.3
No0.03 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.4
No.04 Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NELLAN IP Address 172.18.0.5
No0.05 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NELLAN IP Address 172.18.0.6
No0.06 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NELLAN IP Address 172.18.0.7
No0.07 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.8
No0.08 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
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4. Network configuration for Root NE(Bridge)

,

_ — 172.18.0.1
. 255.255.255.192
PNMS /

e T Tl
- e—2" INoo1
Router -l ==
Root NE Normal NE Normal NE Normal NE
Bri
( dge) 172.18.0.3 LAN 172.18.0.4 172.18.0.5
172.18.0.2 255.255.255.192 255.055.255.192 255.255.255.192
255.255.255.192
172.18.0.1 PNMT .
255.255.255.192 Q
Y B/
: '—\’\ No.01 ( 1 | No.04
PNMS "<l __ -
Root NE Normal NE Normal NE Normal NE
Bridge
( 9 ) 172.18.0.3 LAN 172.18.0.4 172.18.0.5
172.18.0.2 255.255.255.192 255.255.255.192 255.255.255.192
255.255.255.192
CTRL Type
NE (General) Category Item Name Input data
Root NE Radio/NEL/LAN IP Address 172.18.0.2
No.01 (Bridge) Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.3
No0.02 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.4
No0.03 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
Radio/NEL/LAN IP Address 172.18.0.5
No.04 | Normal NE Subnet Mask 255.255.255.192
Routing Default Gateway 172.18.0.1
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